
NON-PROPRIETARY CALCULATIONS

Book 7 of 8 

Attachments to PG&E Letter DIL-01-004 
Dated December 21, 2001



69-20132 03/07/01
NUCLEAR POWER GENERATION 

CF3.ID4 
ATTACHMENT 7.2

Index No. 402 
Binder No.

TITLE: CALCULATION COVER SHEET 

Unit(s): 1 & 2 File No.: 52.27 

Responsible Group: Civil Calculation No.: 52.27.100.732 

No. of Pages 3 pages + Index (4 pages) + 2 Design Calculation YES [x] NO [ ] 
Attachments (169 pages) 

System No. 42C Quality Classification Q (Safety-Related) 

Structure, System or Component: Independent Spent Fuel Storage Facility 

Subject: Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site (GEO.DCPP.01.22, 
Rev. 1) 

Electronic calculation YES [ ] NO [x] 

Computer Model Computer ID Program Location Date of Last 
Change 

Registered Engineer Stamp: Complete A or B 

A. Insert PE Stamp or Seal Below B. Insert stamp directing to the PE stamp or seal 

REGISTERED ENGINEERS' 
STAMPS AND EXPIRATION DATES 

ARE SHOWN ON DWG 063618 

Expiration Date: 

NOTE 1: Update DCI promptly after approval.  

NOTE 2: Forward electronic calculation file to CCTG for uploading to EDMS.

1

Page I of 3



69-2013ý ,,3/07/01
C 

CF3.ID4 
ATTACHMENT 7.2

TITLE: CALCULATION COVER SHEET 

CALC No. 52.27.100.732, RO 

RECORD OF REVISIONS 

Rev Status Reason for Revision Prepared LBIE LBIE Check LBIE Checked Supervisor Registered 

No. By: Screen Method* Approval Engineer 

Remarks Initials/ Yes/ Yes/ PSRC PSRC Initials/ Initials/ Signature/ 

LAN ID/ No/ No/ Mtg. Mtg. LAN ID/ LAN ID/ LAN ID/ 

Date NA NA No. Date Date Date Date 

0 F Acceptance of Geosciences Calc. AFT2 ] ] Yes [ ] Yes [ ] A N/A N/A N/A -2/9 

No. GEO.DCPP.01.22, Rev. 0. A, [ ] No [ ] No [ ] B 
Cale. supports current edition of A-1 ] No/[ o [ ] 

10CFR72 DCPP License x NA x NA x I C 

Application to be reviewed by NRC 
prior to implementation.  

Prepared per CF3.ID17.  

[ ]Yes [ ]Yes [ ]A 

[]No []No []B 

[ NA [ ]NA [ ]C 

[ ]Yes [ ]Yes [ ]A 

[]No []No [lB 

A ]NA p CNA P C 

*Check Method: A: Detailed Check, B: Alternate Method (note added pages), C: Critical Point Check

2

Page 3



Pacific Gas and Electric Company 
Engineering - Calculation Sheet 
Project: Diablo Canyon Unit ( )1 ( )2 (x) 1&2

SUBJECT Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site 

MADE BY A. Tafoya K1 DATE 12/15/01 CHECKED BY

69-392(10/92) 
Engineering 

CALC. NO. 52.27.100.732 

REV. NO. 0 

SHEET NO. 3 of 3 

N/A DATE

Table of Contents:

Item Type 

1 Index 

2 Attachment A 

3 Attachment B

Title

Cross-Index (For Information Only) 

Kinematic Stability Analysis for Cutslopes at 
DCPP ISFSI Site 

DIPS User's Guide

Page Numbers

1-4 

1 -79 

1 - 90

3



Pacific Gas and Electric Company 

Engineering - Calculation Sheet 
Project: Diablo Canyon Unit ( )1 ( ) 2 (x) 1&2 

SUBJECT Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site 

'-.- MADE BY A. Tafoya 1 DATE 12/15/01 CHECKED

69-392(10/92) 
Engineering 

CALC. NO. 52.27.100.732 

REV. NO. 0 

SHEET NO. 1-1 of 4 

BY N/A DATE

1- This table cross references between Geosciences calculation numbers and DCPP (Civil Group's) 
calculation numbers. This section is For Information Only.  

Cross-Index 
(For Information Only) 

Item Geosciences Title PG&E Calc. Comments 
No. Calc. No. No.  

1 GEO.DCPP.01.01 Development of Young's 52.27.100.711 
Modulus and Poisson's 
Ratios for DCPP ISFSI 
Based on Field Data 

2 GEO.DCPP.01.02 Determination of 52.27.100.712 
Probabilistically Reduced 
Peak Bedrock 
Accelerations for DCPP 
ISFSI Transporter 
Analyses 

3 GEO. DCPP.01.03 Development of Allowable 52.27.100.713 
Bearing Capacity for DCPP 
ISFSI Pad and CTF 
Stability Analyses 

4 GEO.DCPP.01.04 Methodology for 52.27.100.714 
Determining Sliding 
Resistance Along Base of 
DCPP ISFSI Pads 

5 GEO.DCPP.01.05 Determination of 52.27.100.715 
Pseudostatic Acceleration 
Coefficient for Use in 
DCPP ISFSI Cutslope 
Stability Analyses 

6 GEO.DCPP.01.06 Development of Lateral 52.27.100.716 
Bearing Capacity for DCPP 
CTF Stability Analyses 

7 GEO.DCPP.01.07 Development of Coefficient 52.27.100.717 
of Subgrade Reaction for 
DCPP ISFSI Pad Stability 
Checks 

8 GEO.DCPP.01.08 Determination of Rock 52.27.100.718 
Anchor Design Parameters 
for DCPP ISFSI Cutslope 

9 GEO.DCPP.01.09 Determination of 52.27.100.719 Calculation to be 
Applicability of Rock Elastic replaced by letter

1



Pacific Gas and Electric Company 

Engineering - Calculation Sheet 

"Project: Diablo Canyon Unit ( )1 ( ) 2 (x) 1&2 

SUBJECT Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site

.--<" MADE BY A. Tafoya K DATE 12/15/01 CHECKED BY N/A DATE

Cross-Index 
(For Information Only)

Item Geosciences Title PG&E Calc. Comments 
No. Calc. No. No.  

Applicability of Rock Elastic replaced by letter 
Stress-Strain Values to 
Calculated Strains Under 
DCPP ISFSI Pad 

10 GEO.DCPP.01.10 Determination of SSER 34 52.27.100.720 
Long Period Spectral 
Values 

11 GEO.DCPP.01.11 Development of ISFSI 52.27.100.721 
Spectra 

12 GEO.DCPP.01.12 Development of Fling 52.27.100.722 
Model for Diablo Canyon 
ISFSI 

13 GEO.DCPP.01.13 Development of Spectrum 52.27.100.723 
Compatible Time Histories 

14 GEO.DCPP.01.14 Development of Time 52.27.100.724 
Histories with Fling 

15 GEO.DCPP.01.15 Development of Young's 52.27.100.725 
Modulus and Poisson's 
Ratio Values for DCPP 
ISFSI Based on Laboratory 
Data 

16 GEO.DCPP.01.16 Development of Strength 52.27.100.726 
Envelopes for Non-jointed 
Rock at DCPP ISFSI 
Based on Laboratory Data 

17 GEO.DCPP.01.17 Determination of Mean and 52.27.100.727 
Standard Deviation of 
Unconfined Compression 
Strengths for Hard Rock at 
DCPP ISFSI Based on 
Laboratory Tests 

18 GEO.DCPP.01.18 Determination of Basic 52.27.100.728 
Friction Angle Along Rock 
Discontinuities at DCPP 
ISFSI Based on Laboratory

2

69-392(10/92) 
Engineering 

CALC. NO. 52.27.100.732 

REV. NO. 0 

SHEET NO. 1-2 of 4



!I Pacific Gas and Electric Company 

Engineering - Calculation Sheet 
Project: Diablo Canyon Unit ( )1 ( ) 2 (x) 1&2 

SUBJECT Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site 

MADE BY A. Tafoya k DATE 12/15/01 CHECKED BY N/A

69-392(10/92) 
Engineering 

CALC. NO. 52.27.100.732 

REV. NO. 0 

SHEET NO. 1-3 of 4 

DATE

Cross-Index 
(For Information Only) 

Item Geosciences Title PG&E CaIc. Comments 

No. Calc. No. No.  

Hoek-Brown Equations 

20 GEO.DCPP.01.20 Development of Strength 52.27.100.730 
Envelopes for Shallow 
Discontinuities at DCPP 
ISFSI Using Barton 
Equations 

21 GEO.DCPP.01.21 Analysis of Bedrock 52.27.100.731 
Stratigraphy and Geologic 
Structure at the DCPP 
ISFSI Site 

22 GEO.DCPP.01.22 Kinematic Stability Analysis 52.27.100.732 
for Cutslopes at DCPP 
ISFSI Site 

23 GEO.DCPP.01.23 Pseudostatic Wedge 52.27.100.733 
Analyses of DCPP ISFSI 
Cutslopes (SWEDGE 
Analysis) 

24 GEO.DCPP.01.24 Stability and Yield 52.27.100.734 
Acceleration Analysis of 
Cross-Section I-I' 

25 GEO.DCPP.01.25 Determination of Seismic 52.27.100.735 
Coefficient Time Histories 
for Potential Siding Masses 
Along Cut Slope Behind 
ISFSI Pad 

26 GEO.DCPP.01.26 Determination of 52.27.100.736 
Earthquake-Induced 
Displacements of Potential 
Sliding Masses on ISFSI 
Slope 

27 GEO.DCPP.01.27 Cold Machine Shop 52.27.100.737 
Retaining Wall Stability 

28 GEO.DCPP.01.28 Stability and Yield 52.27.100.738 
Acceleration Analysis of 
Potential Sliding Masses 
Along DCPP ISFSI 
Transport Route

3



Pacific Gas and Electric Company 

Engineering - Calculation Sheet 
Project: Diablo Canyon Unit ( )1 ( )2 (x) 1&2

69-392(10/92) 
Engineering 

CALC. NO. 52.27.100.732 

REV. NO. 0 

SHEET NO. 1-4 of 4

SUBJECT Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site

A. Tafoya 0 DATE 12/15/01 CHECKED BY N/A DATE

Cross-Index 
(For Information Only) 

Item Geosciences Title PG&E Calc. Comments 
No. Cale. No. No.  

Retaining Wall Stability 

28 GEO.DCPP.01.28 Stability and Yield 52.27.100.738 
Acceleration Analysis of 
Potential Sliding Masses 
Along DCPP ISFSI 
Transport Route 

29 GEO.DCPP.01.29 Determination of Seismic 52.27.100.739 
Coefficient Time Histories 
for Potential Sliding 
Masses on DCPP ISFSI 
Transport Route 

30 GEO.DCPP.01.30 Determination of Potential 52.27.100.740 
Earthquake-Induced 
Displacements of Potential 
Sliding Masses Along 
DCPP ISFSI Transport 
Route 

31 GEO.DCPP.01.31 Development of Strength 52.27.100.741 
Envelopes for Clay Beds at 
DCPP ISFSI 

32 GEO.DCPP.01.32 Verification of Computer 52.27.100.742 
Program SPCTLR.EXE 

33 GEO.DCPP.01.33 Verification of Program 52.27.100.743 
UTEXAS3 

34 GEO.DCPP.01.34 Verification of Computer 52.27.100.744 
Code - QUAD4M 

35 GEO.DCPP.01.35 Verification of Computer 52.27.100.745 

Program DEFORMP 

36 GEO.DCPP.01.36 Reserved 52.27.100.746 

37 GEO.DCPP.01.37 Development of Freefield 52.27.100.747 
Ground Motion Storage 
Cask Spectra and Time 
Histories for the Used Fuel 
Storage Project

4

MADE BY



Calculation 52.27.100.732, Rev. 0, Attachment A, Page t of Mc. 15. 2001 4: UOH-i r- ) 

FROM : Cluf - San Francisco PHONE NO. : 415 564 6697 
,.----- NO.089 P.2/5

PG&E 
Geoscleracs Department 
Departmental Calculation Procedure 

Title: Calcuration Cover Sheet

PACIFIC GAS AND ELECTRIC COMPANY 
GEOSCIENCES DEPARTMENT 

CALCULATION DOCUMENT

Page: 1 of 1

Calc Number, GEO.DCPP.01,22 

Revislon: I 
Date: December 14, 2001 
No. of Cale Pages- 167 
Verification Method: A 

No. of Verlflcatlon Pagee; 3

TITLE Kinematlo Stabilli Analysia for Cutalopes at DCPP ISFSI Site

PREPARED BY 

VERIFIED BY 

APPROVED BY

9L.=,-- DATE 

Charles M. Brankmern 
Jeff Baohhuber 
Printed Name 

••L •±_4 DATE 

Scott C. LUndvall 
Printed Name 

-cŽý- DATE 
Lloyd S. Cluff 
Printed Name

12/14/01 

William Lettls & Aasoclatm, Inc.  
Organization 

Wl~lem Latfi & Assoc~latse, Inc.  

Organization 

PG&E Geoeoienoes 
Organization

" No, E67 t 

l olllelil ;§•

GEO.DCP,01.22 Rev. I
Dcccmbcr 14, 2001Paso 1 of 168



Calculation 52.27.100.732, Rev. 0, Attachment A, Page _L of 79

PG&E 
Geosciences Department 
Departmental Calculation Procedure 

Title: Calculation Cover Sheet

PACIFIC GAS AND ELECTRIC COMPANY 
GEOSCIENCES DEPARTMENT 

CALCULATION DOCUMENT

Page: 1 of 1

Calc Number: GEO.DCPP.01.22 

Revision: 1 

Date: December 14, 2001 

No. of Calc Pages: 167 

Verification Method: A 

No. of Verification Pages: 3

TITLE Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site

PREPARED BY 

VERIFIED BY

APPROVED BY

Charles M. Brankman/ 
Jeff Bachhuber 
Printed Name 

Scott C. Lindvall 
Printed Name 

Lloyd S. Cluff 
Printed Name

DATE 12/14/01 

William Lettis & Associates, Inc.  

Organization 

DATE 

William Lettis & Associates, Inc.  
Organization

DATE

PG&E Geosciences 
Organization

GEO.DCPP.0 1.22 Rev. 1 Page I of 168 December 14, 2001



Calculation 52.27.100.732, Rev. 0, Attachment A, Page _ of 79

PG&E 
Geosciences Department 
Departmental Calculation Procedure Page: 1 of 1 

Title: Record of Revision 

Calc Number: GEO.DCPP.01.22, Revision 1 

Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site

GEO.DCPP.01.22 Rev. 1

Rev. No. Reason for Revision -Revision Date 

0 Initial issue; incorporate A. TafoyalGeosciences review comments 11/6/01 

1 Incorporate additional review comments by A. Tafoyaf 12/14/01 
Geosciences

Page 2 of 168 December 14, 2001



Calculation 52.27.100.732, Rev. 0, Attachment A, Page Aof 79

DCPP ISFSI 

CALCULATION PACKAGE GEO.DCPP.01.22 

Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site

GEO.DCPP.01.22 Rev. 1 Page 3 of 168 December 14, 2001



Calculation 52.27.100.732, Rev. 0, Attachment A, Page b of 79

DCPP ISFSI 

CALCULATION PACKAGE GEO.DCPP.01.22 

Kinematic Stability Analysis for Cutslopes at DCPP ISFSI Site 

Table of Contents 

1.0 PU R PO SE ...................................................................................................... 5 

2.0 BA C K G R O U N D ................................................................................................. 6 
3.0 IN PU T S ........................................................................................................... 7 
4.0 A SSU M PTIO N S ................................................................................................. 7 

5.0 M ET H O D ........................................................................................................ 9 
6.0 SO FT W A RE ..................................................................................................... 11 

7.0 A N A L Y SIS ........................................................................................................ 12 

8.0 R E SU L T S .............................................................................................................. 14 

9.0 C O N C LU SIO N S ............................................................................................... 15 

10.0 R EFER EN C ES ................................................................................................. 16 

List of Tables 
Table 22-1. Summary of Discontinuity Sets Identified by Kinematic Analyses 
Table 22-2. Summary of Stability Hazards Identified by Kinematic Analyses 

List of Figures 
Figure 22-1 Map showing locations of borings and trenches used for kinematic 

analyses.  
Figure 22-2 Location of discontinuity surveys along Reservoir Road.  
Figure 22-3 Examples of kinematic analyses.  
Figure 22-4 Kinematic analyses of Westcut ISFSI cutslope.  
Figure 22-5 Kinematic analyses of Backcut ISFSI cutslope.  
Figure 22-6 Kinematic analyses of Eastcut ISFSI cutslope.  
Figure 22-7 Kinematic analyses of north-trending cutslope of Transport Route 

(Stations 43+00 to 46+00).  
Figure 22-8 Kinematic analyses of northwest-trending cutslope of Transport Route 

(Stations 35+00 to 43+00).

List of Attachments 
Attachment 1 - DIPS program input files 

Attachment 2 - DIPS program verification runs 
Attachment 3 - DIPS data presentation verification runs 

Attachment 4 - DIPS program manual

GEO.DCPP.01.22 Rev. 1 Page 4 of 168 December 14, 2001



Security-Related Information – Withhold Under 10 CFR 2.390. 



Calculation 52.27.100.732, Rev. 0, Attachment A, Page _1 of 79

2.0 BACKGROUND 

Stereographic projections of fracture data are tools commonly used to predict the types of 

discontinuity-controlled rock slope failures that are possible for given cutslope 

configurations and rock friction angles. Kinematic analyses of discontinuity data allow 

for the recognition of potential rock slope stability failures by examining the geometric 

relationships between discontinuity surfaces and the rock face. The technique is simple 

and easily performed, and the effects of various rock friction angles and different rock 

cutslope configurations are readily seen.  

Kinematic analyses consider three primary failure modes: (1) topple failure of rock 

blocks and slabs, (2) planar sliding of rock on a single discontinuity or single 

discontinuity set, and (3) wedge sliding of rock along the intersection of two 

discontinuities. Other modes of slope failure, such as rotational slump failures, are not 

considered. Topple failures occur as blocks or slabs, which are bounded by 

discontinuities that dip steeply into the face at angles such that the center of mass falls 

outside the toe of the block and causes outward rotation and topple out of the cut face.  

Planar sliding failures occur when a rock mass slides along a single, optimally-oriented 

surface that dips out of the slope face. Wedge failures involve block sliding along two 

favorably oriented intersecting fractures in the direction of the plunge of the intersection 

line. Each of these failure scenarios is examined through a separate kinematic analysis.  

In general, several conditions must be met for kinematic instability. For toppling-type 

failures, discontinuities must be subparallel to, and dip steeply into, the rock face. For 

sliding-mode failures (planar and wedge sliding), two conditions must be met. First, the 

discontinuity surface (or intersection line between discontinuities) must daylight in the 

cutslope, i.e. the discontinuities must dip in the direction of the cutslope and be less steep 

than the cutslope angle. Second, the discontinuities (or discontinuity intersections) must 

dip at greater than the rock friction angle (Wyllie, 1992). If these criteria are not met,
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failure of the rock slope by sliding along discontinuities is resisted by adjacent rock 

blocks, and thus is not kinematically possible.  

3.0 INPUTS 

Discontinuity data (joints, faults, and bedding) collected from rock outcrops, exploratory 

trenches, roadcuts, and boreholes were used as the basis for the kinematic stability 

analyses. These data are presented in William Lettis & Associates, Inc. (2001), Diablo 

Canyon ISFSI Data Reports B, E, and F. Every discontinuity measurement from the test 

trenches at the ISFSI site was used in the kinematic analyses. Discontinuity data from 

boreholes were taken from the geophysical image logs; however, only the discontinuities 

that were confirmed by at least two geologists in order to verify the presence and type of 

discontinuity and the accuracy of the orientation were included. The input files 

containing the discontinuity data used in each analysis are included in Attachment 1. The 

joint and fault data are identical to those shown in Table 21-7, which were used to create 

the rose diagrams in Calculation Package GEO.DCPP.01.21. For the kinematic analyses, 

bedding data was included with the joint and fault data.  

Friction angles used for the kinematic analyses were obtained from direct shear testing of 

fractures and bedding planes; these data are presented in William Lettis & Associates, 

Inc. (2001), Diablo Canyon ISFSI Data Report I, and in Calculation Package 

GEO.DCPP.01.20. The geometry of the ISFSI excavation and cutslopes is taken from 

drawing PGE-009-SK-001, transmitted to Geosciences on September 27, 2001 (Page, 

2001). The analyses use a 70' angle for the cutslope walls, as shown in the drawing.  

4.0 ASSUMPTIONS 

The following assumptions were made for the kinematic analyses:
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1. The potential shallow rock slope failures are controlled primarily by laterally 

persistent discontinuities that bound intact rock blocks. Discontinuities in the ISFSI 

study area are observed generally to be continuous over I to 3 feet and, in places, up 

to about 14 feet, and intersect to form discrete rock blocks of similar dimensions 

(William Lettis & Associates, Inc. (2001), Diablo Canyon ISFSI Data Report F).  

Therefore this assumption is realistic for these dimensions.  

2. The shear strength of the fractured rock mass is controlled only by the basal rock 

friction angle of the discontinuities. This is a conservative assumption because other 

factors that may impact shear strength, such as cohesion, asperity interlocking, or the 

presence of intact rock bridges across discontinuities, are not considered in this 

analysis.  

3. Rock friction angle is assumed to be 28'. This value is based on direct shear 

laboratory testing of joints (William Lettis & Associates, Inc. (2001), Diablo Canyon 

ISFSI Data Report I) and the Barton criterion analyses (see Calculation Package 

GEO.DCPP.01.20). The value chosen is considered a conservative value, because it 

is the near lower-bound of the straight line fits to the mean Barton envelopes for all 

discontinuity types.  

4. Only the geometric relationships between the discontinuities and the cutslope are 

used in the analyses. The kinematic analyses assume no rock reinforcement to the 

slope. External forces, such as seismic loads and hydrostatic pressures, are not 

considered in the kinematic analyses. These factors increase the risk of slope failure 

identified in the kinematic analyses, but do not affect the analysis. These factors are 

considered in Calculation Package GEO.DCPP.01.23.
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5.0 METHOD 

The step-by-step methodology used for the kinematic analyses for each of the three 

cutslopes (Eastcut, Backcut, and Westcut) and the existing road cuts on the transport 

route along Reservoir Road is listed below: 

I. Compilation of discontinuity data from road cuts, trenches and borings near the 

slope being analyzed; 

2. Development of stereographic projections of discontinuity data using the 

computer program DIPS (Rocscience, 1999), and identification of major 

discontinuity sets; and 

3. Analyses of topple, planar sliding, and wedge sliding hazards.  

Step 1 

Discontinuity data were collected from road cuts, exploratory trenches and boreholes 

throughout the ISFSI study area. Details on the collection of these data are presented in 

William Lettis & Associates, Inc. (2001), Diablo Canyon ISFSI Data Reports B, E and F.  

For each wall of the proposed cut and for the roadcut, the data set from nearby trenches, 

borings, and roadcut were compiled to form distinct data sets for the analyses (Figures 

22-1 and 22-2). The cutslope-specific data sets enable the evaluation to focus on local 

differences in discontinuity geometry, and identification of potential failure modes 

specific to each cutslope wall. Each discontinuity was classified in the field as either a 

joint, fault, or bedding surface, and this classification was carried into the DIPS input file.  

The DIPS input files are included in Attachment 1.  

Step 2 

For each cutslope and road cut segment, the discontinuity data from the appropriate 

trenches, boreholes, and outcrops are plotted on an equal angle stereonet. As described 

above, the plot shows discontinuities defined by discontinuity type (joint, fault, bedding).
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After plotting the data, sets of discontinuities were defined based on contouring and 

clustering of similar orientations. Only fracture groups that show well-defined clustering, 

on the basis of the scatter plots and the contour plots of the data, are grouped as 

discontinuity sets. Attributes of each defined discontinuity set, such as average 

orientation and variability to two standard deviations, are calculated by the DIPS 

software.  

Step 3 

After defining the discontinuity sets, analyses for each mode of potential failure was 

performed. The procedure for each analysis is briefly described below.  

Topple failure - Topple failure of rock blocks is possible when discontinuities 

strike within about 300 of the cutslope, and dip steeply into the slope. On the 

stereographic projection, the pole to the discontinuity must fall within 30' to the dip 

direction of the cutslope, and must plot above a line inclined at an angle equivalent to the 

friction angle above the cutslope to be considered to have a potential of topple failure 

(blue-shaded area in Figure 22-3A) (Rocscience, 1999).  

Planar sliding failure - In order for planar sliding to occur, discontinuities must be 

present that strike within about 200 of the cutslope, and which dip at a shallower angle 

than the cutslope but steeper than the rock friction angle (Wyllie, 1992). On the 

stereographic projection, the pole to the discontinuity must fall within the daylight 

envelope of the cutslope but outside the rock friction cone to be considered to have a 

potential for planar sliding (blue-shaded area in Figure 22-3B).  

Wedge sliding failure - Wedge sliding of rock blocks occurs when the 

intersection line between two discontinuities plunges in the direction of the cut face at an 

angle steeper than the rock friction angle but less steep than the angle of the cutslope 

(Wyllie, 1992). On the stereographic projection, the line of intersection between two 

discontinuities sets plots as a point. This point must fall outside the cutslope great circle 

but within the rock friction cone to be considered to have the potential for wedge sliding
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(blue-shaded area in Figure 22-3C). Note that the rock friction cone in this analysis is 

counted in from the edge of the stereonet instead of out from the center, which is the 

reverse of the analysis for planar sliding; this is done because this analysis uses the great 

circles instead of the poles to assess the hazard (Rocscience, 1999).  

6.0 SOFTWARE 

Fracture data visualization and kinematic analyses were performed using DIPS, v. 5.041 

(Rocscience, 1999) on a DELL Dimension model XPS desktop computer running the 

Microsoft Windows 98 operating system. The software was purchased by and is licensed 

to William Lettis & Associates, Inc. (WLA), and all analyses were performed by WLA.  

The program has not been modified from the version purchased from Rocscience. Data 

tabulation, visualization, and kinematic analyses were performed using standard DIPS 

functions.  

The following program items were also identified as part of the verification process: 

a) program name: DIPS 

b) program version: 5.041 

c) program revision: not applicable 

d) computer platform compatibility: Windows 98 

e) program capabilities and limitations: The program performs kinematic stability 

analyses by plotting discontinuity data on stereonets, then analyzing if the data meet 

the requirements for stability in three failure modes: toppling, planar sliding, and 

wedge sliding.  

f) program test cases: described in Attachment 2.  

g) instructions for use: input orientations of discontinuity planes (joints, faults, 

bedding), a slope face, and friction angles as described in Rocscience (1999).  

h) program owner: Rocscience.  

i) identification of individual responsible for controlling the software or executables: 

Geosciences QA Coordinator.
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j) change control: The software used in this calculation is stored on a CD filed with the 

calculation file. Only use this software version when re-running or revising this 

calculation. Contact the Geosciences QA Coordinator for access to this software.  

k) verification methods used: Verification method 1 (comparison with well documented 

examples in software manuals) was used for verification of the accuracy of the DIPS 

software analysis capabilities, and is shown in Attachment 2. Verification method 3 

(comparison of outputs from alternate independent methods such as by hand 

calculation) was used to verify that the software correcfly plots discontinuity data on 

stereonets, and is shown in Attachment 3.  

7.0 ANALYSIS 

Separate analyses were performed for each of the three cutslopes in the ISFSI excavation 

and the two reaches of the transport route on Reservoir Road. Only data from nearby 

road cuts, trenches and borings were used in the analyses for each cutslope. Trenches, 

borings, and roadcuts used in each analysis are shown in Figure 22-1. Discontinuity data 

used in the analyses are shown in the input files presented in Attachment 1. Summaries 

of the discontinuity sets are included in Table 22-1.  

Westcut 

Data from trenches T- I1 and T-18, borings 01-A, 01-B, 01-H, and discontinuity survey 

DS-1 were included in the analyses for the Westcut. A total of 211 discontinuity 

measurements were included in this data set (Attachment 1). The stereographic plots 

show clustering of discontinuities into four sets (Figure 22-4): (1) a WNW striking, 

steeply dipping set; (2) a NNW striking, steeply SSW dipping set; (3) a WNW to W 

striking, steeply N dipping set; and (4) a NW striking, shallowly dipping set. The 

remainder of the discontinuities are distributed throughout the stereonet without clear 

clustering, representing fractures with orientations not corresponding to a well-defined 

set.
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Backcut 

Data from trenches T-3, T-4, T-5, T-6, T- 11, T-12, T-18, and T-20, discontinuity survey 

DS-1 and borings OOBA-2, 01-F, and 01-H were included in the analyses for the Backcut.  

A total of 421 discontinuity measurements were included in this data set (Attachment 1).  

The data show clustering of discontinuities into four groups (Figure 22-5): (1) a N to 

NNW striking, steeply dipping set; (2) a NW striking, moderately steeply SW dipping 

set; (3) a WNW striking, steeply dipping set; and (4) a NW striking, shallowly SW 

dipping to flat set. The remainder of the discontinuities are distributed throughout the 

stereonet without clear clustering, representing fractures with orientations not 

corresponding to a well-defined set.  

Eastcut 

Data from trenches T-3, T-4, T-20, and T-21, and borings OOBA-2, 0l-E, and 01-G were 

included in the analyses for the Eastcut. A total of 167 discontinuities were included in 

this data set (Attachment 1). The data show discontinuities grouping into four clusters: 

(1) a NNE striking, steeply dipping set (Figure 22-6); (2) a NW striking, moderately 

steeply SW dipping set; (3) a NW striking, shallowly dipping to flat set; and (4) a W 

striking, steeply N dipping set. The remainder of the discontinuities are distributed 

throughout the stereonet without clear clustering, representing fractures with orientations 

not corresponding to a well-defined set.  

Transport Route Cutslopes 

Data from road cuts along Reservoir Road were included for the analyses of rock slopes 

along the Transport Route. A total of 37 discontinuity measurements were collected and 

included in this data set (Attachment 1). Two portions of the transport route were 

considered: the north-trending portion (stations 43+00 to 46+00), which is inclined at 50', 

and the northwest-trending portion (stations 35+00 to 43+00), which is inclined at 300.  

Each transport route analysis was performed using the entire discontinuity data set from 

the roadcut (37 measurements). The data show discontinuities grouping into three 

clusters (Figures 22-7 and 22-8): (1) a NW striking, steeply dipping set; (2) a NE striking, 

moderately S dipping set; and (3) a ENE striking, moderately N dipping set.
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8.0 RESULTS 

Figures 22-4 through 22-6 show the output of the kinematic analyses for each wall of the 

proposed ISFSI cutslope. Figures 22-7 and 22-8 show the analyses for the transport route 

along Reservoir Road.  

Westcut 

Analyses of the Westcut are shown in Figure 22-4. The Westcut shows a high potential 

for topple failure. The majority of discontinuity set 2, as well as some fractures from 

set 1, plot within the zone of potential failure for toppling. However, analyses of planar 

and wedge sliding failures show low to very low potential, respectively, for these modes 

of failure in the western slope, as very few discontinuities (and none belonging to any of 

the defined sets) fall within the failure envelope for planar sliding, and none of the 

discontinuity intersections fall within the failure envelope for wedge sliding failure. Thus 

the only identified significant failure mode for the southwestern cutslope is topple failure.  

It should be noted that a portion of the southwestern cutslope will be infill, and, as such, 

the failure mode identified above is not applicable in these fill slopes.  

Backcut 

Kinematic analyses of the Backcut are shown in Figure 22-5. The slope shows low 

potential for toppling failure, as only a few random discontinuities plot within this failure 

envelope. Planar sliding failure represents a low- to moderate-potential, as a few 

discontinuities from sets 1 and 2, as well as a number of random discontinuities, plot 

within the planar sliding failure envelope. Potential exists for wedge sliding along the 

intersection line of discontinuity sets 2 and 3, while another intersection (1 and 3) plots 

outside but relatively close to the failure envelope and should be considered a potential 

hazard, given that these lines represent the average orientation of the set and that there is 

a scatter of orientations around this mean. Thus, there is a high potential for wedge 

failure and minor planar sliding failure on the Backcut.
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Eastcut 

Kinematic analyses of the Eastcut are shown in Figure 22-6. The slope shows low 

potential for toppling failure, as only a few random discontinuities plot within this failure 

envelope. There is a moderate to high potential for planar sliding failure, as numerous 

discontinuities from discontinuity set 2 as well as some random discontinuities plot 

within the planar sliding failure envelope. Potential also exists for wedge sliding along 

the intersection lines between discontinuity sets 1 and 2 and between sets 2 and 4; though 

these intersections plot very close to the failure envelope, these lines represent the 

average orientation of the set and there is a scatter of orientations around this mean.  

Thus, there is a moderate to high potential for planar sliding and a moderate to high 

potential for wedge sliding failures along the Eastcut.  

Transport Route Cutslopes 

Kinematic analyses of the transport route cutslopes are shown in Figure 22-7 and 22-8.  

The north-trending slope shows moderate potential for toppling failure, as a large portion 

of set 1 plot within this failure envelope. There is low potential of planar sliding failure, 

and very low potential for wedge sliding failure. The northwest-trending slope shows 

low potential for all three failure modes. This is because of the very low inclination of 

this slope. Thus, the only the potentially significant failure mode is for topple failures 

along the transport route cutslopes.  

9.0 CONCLUSIONS 

Stereographic kinematic analyses of discontinuity-controlled shallow rock slope failures 

in the proposed ISFSI excavation cutslopes show that each of the three cutslopes are 

prone to potential shallow rock stability hazards, but failure modes and potential for 

failure vary between slopes. The results are summarized in Table 22-2. The Westcut 

will primarily be prone to toppling failure of rock blocks into the cut along steeply 

dipping discontinuities. The Backcut has a high potential of wedge failures along two 

discontinuity sets, a minor potential of planar sliding, and low potential of topple failure.  

The Eastcut is prone primarily to planar wedge sliding, with little topple failure hazard.
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The transport route exhibits a low potential for rock topple, planar slide, and wedge 

sliding. These results will be used in the psuedostatic stability analyses of potential 

wedge failures (Calculation Package GEO.DCPP.01.23). Specific engineering measures 

will be required to mitigate the hazards associated with these potential failures.  
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Table 22-1. Summary of discontinuity sets identified by kinematic analyses.

(1) Average dip and dip direction of discontinuity sets, as determined from stereographic 
plots of discontinuity data.
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Table 22-2. Summary of stability hazards identified by kinematic analyses.

GEO.DCPP.01.22 Rev. I

Type of Stability Hazard 

Area of Analysis 
Topple Planar Sliding Wedge Sliding 

Westcut High Low Very Low 

Backeut Low Low - Moderate High 

Eastcut Low Moderate - High Moderate - High 

North Transport Moderate Low Very Low 
Route 

Northwest Transport Low Very Low Very Low 
Route
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Explanation 
Poles 

1 Bedding 
P. Fault 

, Joint 

Failure envelope 
(based on 280 
friction angle)

Great circle of 
friction angle above 
cutslope

Cutslope

A. Topple hazard

Failure envelope for topple and planar 
sliding without poles indicates stable 
conditions.  

Failure envelope for wedge sliding 
without great circle intersections 
indicates stable conditions.

2cy Variability

1 a Variability

-E Average 
orientation of 
discontinuity 
set

B. Planar sliding hazard C. Wedge sliding hazard

Notes 
Analysis performed using computer program DIPS, 
v. 5.041 (Rocscience, 1999).
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DIABLO CANYON ISFSI 

FIGURE 22-3 
EXAMPLES OF KINEMATIC ANALYSES 
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Explanation

Set 1

3et 4

Poles 

n Bedding 

• Fault 

o Joint

Failure envelope 
(based on 280 
friction angle) 

Failure envelope for topple and planar 
sliding without poles indicates stable 
conditions.  

Failure envelope for wedge sliding 
without great circle intersections 
indicates stable conditions.

A. Topple hazard (high hazard)

Set 2

Set 4

Set 3

S

B. Planar sliding hazard (low hazard)
C. Wedge sliding hazard (very low hazard)

Notes

Analysis performed using computer program 
DIPS, v. 5.041 (Rocscience, 1999).  

Data for westcut analyses taken from trenches 
T-11 and T-18, borings 01-A, 01-B, 01-H, and 
discontinuity survey DS-1.

GEO.DCPP.01.22 REV 1

Page 23 of 168

Set 2

Set 3

DIABLO CANYON ISFSI 

FIGURE 22-4 
KINEMATIC ANALYSES OF WESTCUT 

ISFSI CUTSLOPE

December, 2001
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Explanation 
Poles

Set 4

Set 1

3 Bedding 

l Fault 

o Joint 

Failure envelope 
(based on 280 
friction angle) 

Failure envelope for topple and planar 
sliding without poles indicates stable 
conditions.  

Failure envelope for wedge sliding 
without great circle intersections 
indicates stable conditions.

A. Topple hazard (low hazard)

Set 1

Set 3

Set

B. Planar sliding hazard (low to moderate hazard)

Notes 
Analysis performed using computer program DIPS, v. 5.041 
(Rocscience, 1999).  

)ata for backcut analyses taken from trenches T-3, T-4, T-5, T
"--6, T-1 1, T-12, T-18, and T-20, discontinuity survey DS-1 and 

borings OOBA-2, 01-F, and 01-H.

C. Wedge sliding hazard (high hazard)

GEO.DCPP.01.22 REV 1
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DIABLO CANYON ISFSI 

FIGURE 22-5 
KINEMATIC ANALYSES OF 

BACKCUT ISFSI CUTSLOPE

December, 2001
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Explanation 

Poles 

n Bedding 

k , Fault 
0 Set 2 o Joint 

0 

0 00 

0 0 Failure envelope 
ýp"0 0 (based on 280 

0080 friction angle) 

0 cF D 

o 0 Failure envelope for topple and planar 
° ° °°& sliding without poles indicates stable 

", o conditions.  

Failure envelope for wedge sliding 
without great circle intersections 

Qt A indicates stable conditions.

A. Topple hazard (low hazard)

Set 1

"Set 4

Set 3

s 

B. Planar sliding hazard (moderate to high hazard)

Notes 
Analysis performed using computer program DIPS, 
v. 5.041 (Rocscience, 1999).  

Data for eastcut analyses taken from trenches T-3, 
"T-4, T-20 and T-21, and borings OOBA-2, 01-E and 
01-G.

S

C. Wedge sliding hazard (moderate to high hazard)

GEO.DCPRO1.22 REV 1 
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Set 1

N

DIABLO CANYON ISFSI 

FIGURE 22-6 
KINEMATIC ANALYSES OF EASTCUT 

ISFSI CUTSLOPE

December, 2001
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Explanation
Poles

c Joint 

-E E Bedding 

Failure envelope 
(based on 280 
friction angle) 

3 Failure envelope for topple and planar 
sliding without poles indicates stable 
conditions.

A. Topple hazard (moderate hazard)
Failure envelope for wedge sliding 

without great circle intersections 
indicates stable conditions.

Set 1

s

B. Planar sliding hazard (low hazard) C. Wedge sliding hazard (very low hazard)

Notes 
Analysis performed using computer program DIPS, v.  
5.041 (Rocscience, 1999).  

Fracture data from stations 38+00 to 45+00 applied to 
north-trending cut slope above Reservoir Road from 
stations 43+00 to 46+00.

GEO.DCPP.01.22 REV 1
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s

DIABLO CANYON ISFSI 

FIGURE 22-7 
KINEMATIC ANALYSES OF NORTH-TRENDING 

CUTSLOPE OFTRANSPORT ROUTE 
(STATIONS 43+00 TO 46+00)

December, 200



N

3

A. Topple hazard (low hazard)

B. Planar sliding hazard (very low hazard) 

Notes 
Analysis performed using computer program 
DIPS, v. 5.041 (Rocscience, 1999).  

Fracture data from stations 38+00 to 45+00 
applied to northwest-trending cutslope 
above Reservoir Road from stations 35+00 
to 43+00

Failure envelope for topple and planar 
sliding without poles indicates stable 
conditions.  

Failure envelope for wedge sliding 
without great circle intersections 
indicates stable conditions.

Set 1

-E

C. Wedge sliding hazard (very low hazard)

GEO.DCPR01.22 REV 1 December, 2001
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Set 1 

Explanation 
Poles 

o Joint 

a Bedding 

Failure envelope 
(based on 28' 
friction angle)

DIABLO CANYON ISFSI 

FIGURE 22-8 
KINEMATIC ANALYSES OF NORTHWEST
TRENDING CUTSLOPE OFTRANSPORT 

ROUTE (STATION 35+00 TO 43+00)
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ATTACHMENT 1 

Dips Program Input Files
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* This file is 
*The following 

Default Title 
Default Title

DIPS input file for Westcut - SouthWestCut.dip 

generated by Dips for Windows 
2 lines are the Title of this file 
Line 2 
Line 2

Number of Traverses: 0 

* Global Orientation is: 

DIP/DIPDIRECTION 

0 (Declination) 

NO QUANTITY 

Number of extra columns are: 

ID; Dip; Dip Direction

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35

70 
61 
76 
64 
49 
37 
35 
69 
67 
64 
29 
58 
34 
48 
35 
31 
24 
73 
35 
23 
26 
34 
78 
67 
76 
71 
56 
77 
67 
81 
31 
36 
77 
42 
20

264 
240 
235 
265 
199 
257 
358 
184 
249 
248 
182 
194 
55 
39 
225 
251 
243 
93 
229 
284 
224 
240 
192 
192 
150 
243 
223 
54 
231 
30 
171 
330 
50 
188 
230

3

DEPTH;

69.083 
68.545 
68.24 
57.922 
57.577 
56.422 
53.227 
52.954 
51.988 
51.772 
51.682 
51.196 
50.081 
44.392 
42.265 
41.065 
40.711 
39.856 
37 .372 
36. 913 
36.724 
34.384 
33.245 
32. 682 
31.869 
30.474 
23.229 
21.08 
19.973 
16.441 
15.275 
8.838 
7.758 
6.3 
37.8

joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 

joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
beddir

TYPE; TRENCH/BORING; 

01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 
01-A 

ng 01-A
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36 23 251 42.1 bedding 01-A 
37 7 21 54.9 bedding 01-A 
38 23 226 55.8 bedding 01-A 
39 22 259 58.8 bedding 01-A 
40 11 256 64 bedding 01-A 
41 71 215 68.043 joint 01-B 
42 41 245 66.291 joint 01-B 
43 69 250 65.902 joint 01-B 
44 59 237 64.885 joint 01-B 
45 36 194 47.241 joint 01-B 
46 62 214 37.695 joint 01-B 
47 60 266 33.099 joint 01-B 
48 28 277 27.706 joint 01-B 
49 83 257 26.796 joint 01-B 
50 41 259 26.506 joint 01-B 
51 39 163 22.992 joint 01-B 
52 75 243 21.277 joint 01-B 
53 27 180 20.117 joint 01-B 
54 25 326 18.984 joint 01-B 
55 28 273 16.33 joint 01-B 
56 65 229 11.573 joint 01-B 
57 9 325 26 bedding 01-B 
58 10 260 32.5 bedding 01-B 
59 7 276 37.7 bedding 01-B 
60 42 289 91.717 joint 01-H 
61 69 306 91.21 joint 01-H 
62 75 259 82.788 joint 01-H 
63 69 249 77.589 joint 01-H 
64 69 242 75.574 joint 01-H 
65 33 259 66.793 joint 01-H 
66 34 253 66.625 joint 01-H 
67 55 42 28.355 joint 01-H 
68 51 275 24.063 joint 01-H 
69 58 264 22.203 joint 01-H 
70 35 230 16.238 joint 01-H 
71 72 119 14.676 joint 01-H 
72 79 256 11.53 joint 01-H 
73 33 235 9.324 joint 01-H 
74 25 231 7.332 joint 01-H 
75 34 244 7.207 joint 01-H 
76 56 253 6.52 joint 01-H 
77 37 223 5.819 joint 01-H 
78 52 6 4.867 joint 01-H 
79 35 247 4.466 joint 01-H 
80 41 227 4.297 joint 01-H 
81 15 240 39.4 bedding 01-H 
82 13 211 58.7 bedding 01-H 
83 12 225 82.3 bedding 01-H 
84 11 203 89.6 bedding 01-H 
85 21 232 94.5 bedding 01-H 
86 78 10 joint DS-I 
87 75 260 joint DS-I 
88 70 10 joint DS-1 
89 85 345 joint DS-1 
90 77 246 joint DS-I 
91 66 10 joint DS-I 
92 56 206 joint DS-1
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93 90 255 joint DS-1 

94 80 14 joint DS-I 

95 80 235 joint DS-I 

96 85 9 joint DS-I 

97 90 30 joint DS-1 

98 85 11 joint DS-I 

99 65 242 joint DS-1 

100 82 342 joint DS-I 

101 90 345 joint DS-I 

102 75 180 joint DS-i 

103 75 38 joint DS-I 

104 71 260 joint DS-I 

105 85 200 joint DS-I 

106 80 74 joint DS-1 

107 80 9 joint DS-I 

108 65 345 joint DS-1 

109 85 235 joint DS-1 

110 70 8 joint DS-i 

iii 79 122 joint TIl 

112 63 346 joint TIl 

113 80 317 joint TIl 

114 81 15 joint TIl 

115 65 349 joint TIl 

116 78 41 joint TIl 

117 65 314 joint TIl 

118 70 238 joint TIl 

119 70 1 joint TIl 

120 85 285 joint TIl 

121 84 295 joint TIl 

122 75 198 joint TIl 

123 50 355 joint TIl 

124 55 260 joint TIl 

125 86 180 joint TIl 

126 87 255 joint TIl 

127 85 10 joint TIl 

128 70 281 joint TI1 

129 35 314 joint TIl 

130 90 249 joint TIl 

131 82 264 joint TIl 

'132 65 260 Joint TIl 

133 85 171 joint TIl 

134 71 208 joint TIl 

135 89 242 joint TI1 

136 12 305 bedding TIl 

137 90 255 joint TIl 

138 64 0 joint TIl 

139 68 70 joint TIl 

140 72 221 joint TIl 

141 84 61 joint TIl 

142 80 164 joint TIl 

143 76 267 fault TIl 

144 81 66 joint TIl 

145 79 6 joint TIl 

146 79 229 joint TIl 

147 77 193 joint TI1 

148 76 165 joint T18 

149 47 245 joint TI8
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150 80 240 joint T18 

"151 88 148 joint T18 
152 70 237 joint T18 

153 26 235 joint T18 

154 87 300 joint T18 

155 73 228 joint T18 

156 25 230 joint T18 

157 71 232 joint T18 

158 30 218 joint TI8 

159 21 225 joint T18 

160 89 231 joint T18 

161 39 247 joint T18 

162 38 230 joint T18 

163 32 227 joint T18 

164 84 215 joint T18 

165 87 210 joint T18 

166 78 105 joint T18 

167 80 192 joint TI8 

168 72 98 joint T18 

169 84 270 joint T18 

170 84 325 joint T18 

171 80 268 joint T18 

172 25 234 joint T18 

173 87 210 joint T18 

174 82 275 joint T18 

175 72 320 joint T18 

176 76 40 fault T18 

177 78 245 joint T18 

178 88 88 joint T18 

179 79 257 joint TI8 

180 87 100 joint T18 

181 88 95 joint T18 

182 82 280 fault TI8 

183 80 250 joint T18 

184 62 265 joint T18 

185 82 250 joint T18 

186 72 273 joint T18 

187 80 5 joint T18 

188 88 262 joint T18 

189 75 5 joint T18 

190 76 298 joint T18 

191 88 46 joint T18 

192 57 250 joint T18 

193 79 250 joint T18 

194 86 215 joint T18 

195 28 250 joint T18 

196 88 279 joint T18 

197 84 240 joint T18 

198 69 292 joint TI8 

199 70 205 joint TI8 

200 68 285 joint T18 

201 87 210 joint T18 

202 72 287 joint T18 

203 67 257 joint T18 

204 80 205 fault T18 

205 38 325 joint T18 

206 78 80 joint T18
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207 76 10 joint TI8 
208 80 110 joint T18 

209 83 5 fault T18 
210 88 16 fault T18 

211 60 282 joint T18 

* End of File! 
-1
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DIPS input file for Backcut - SouthEastCut.dip

* This file is generated by Dips for 
*The following 2 lines are the Title 

Default Title Line 2 

Default Title Line 2 

Number of Traverses: 0 

* Global Orientation is: 

DIP/DIPDIRECTION 

0 (Declination) 

NO QUANTITY 

Number of extra columns are: 3

ID; Dip; Dip Direction;

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35

40 
18 
74 
48 
67 
66 
41 
40 
44 
48 
72 
71 
64 
68 
42 
79 
61 
57 
60 
62 
66 
48 
66 
66 
72 
65 
70 
53 
38 
29 
65 
40 
43 
71 
31

205 
267 
223 
237 
205 
214 
232 
240 
282 
272 
101 
120 
224 
264 
224 
45 
197 
213 
215 
228 
231 
238 
218 
190 
194 
223 
17 
178 
317 
200 
2 
182 
194 
230 
185

53.453 
50.147 
48.521 
40.597 
39.467 
39.208 
39.113 
38.731 
35.604 
34.321 
27.219 
26.263 
9.438 
127.137 
120.021 
87.824 
82.255 
82.036 
81.472 
81.159 
80.287 
71.965 
69.88 
69.665 
68.299 
64.732 
63.379 
61.017 
58.766 
53.569 
51.178 
50.897 
49.677 
46.728 
43.719

DEPTH; 

joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint

Windows 
of this file

TYPE; TRENCH/BORING; 

00BA-2 
0OBA-2 
00BA-2 
00BA-2 
00BA-2 
00BA-2 
00BA-2 
00BA-2 
OOBA-2 
OOBA-2 
OOBA-2 
OOBA-2 
OOBA-2 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-F
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36 
37 
38 
39 
40 
41 
42 
43 
44 
45 
46 
47 
48 
49 
50 
51 
52 
53 
54 
55 
56 
57 
58 
59 
60 
61 
62 
63 
64 
65 
66 
67 
68 
69 
7.0 
71 
72 
73 
74 
75 
76 
77 
78 
79 
80 
81 
82 
83 
84 
85 
86 
87 
88 
89 
90 
91 
92

32 
34 
53 
9 
14 
9 
42 
69 
75 
69 
69 
33 
34 
55 
51 
58 
35 
72 
79 
33 
25 
34 
56 
37 
52 
35 
41 
15 
13 
12 
11 
21 
78 
75 
70 
85 
77 
66 
56 
90 
80 
80 
85 
90 
85 
65 
82 
90 
75 
75 
71 
85 
80 
80 
65 
85 
70

188 
193 
211 
200 
180 
200 
289 
306 
259 
249 
242 
259 
253 
42 
275 
264 
230 
119 
256 
235 
231 
244 
253 
223 
6 
247 
227 
240 
211 
225 
203 
232 
10 
260 
10 
345 
246 
10 
206 
255 
14 
235 
9 
30 
11 
242 
342 
345 
180 
38 
260 
200 
74 
9 
345 
235 
8

41.198 
26.194 
4.924 
6.8 
94.3 
117 
91.717 
91.21 
82.788 
77.589 
75.574 
66.793 
66.625 
28.355 
24.063 
22.203 
16.238 
14.676 
11 .53 
9.324 
7. 332 
77. 207 
6.52 
5.819 
4.867 
4.466 
4.297 
39.4 
58.7 
82.3 
89.6 
94.5 
0.1 
0.3 
0.3 
0.5 
0.7 
0.9 
0.9 
1 
1 
1.5 
1.5 
1.8 
3 
3.8 
3.8 
4.1 
4.1 
4.8 
4.8 
5 
5.2 
5.2 
5.5 
5.8 
5.8

GEO.DCPP.01.22 Rev. I

joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
bedding 
bedding 
bedding 
bedding 
bedding 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint

01-F 
01-F 
01-F 
01-F 
01-F 
01-F 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
01-H 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-1 
DS-I 
DS-I 
DS-I
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93 79 122 joint T-11 

94 63 346 joint T-11 

95 80 317 joint T-11 

96 81 15 joint T-11 

97 65 349 joint T-11 

98 78 41 joint T-11 

99 65 314 joint T-11 

100 70 238 joint T-11 

101 70 1 joint T-11 

102 85 285 joint T-11 

103 84 295 joint T-11 

104 75 198 joint T-11 

105 50 355 joint T-11 

106 55 260 joint T-11 

107 86 180 joint T-11 

108 87 255 joint T-11 

109 85 10 joint T-11 

110 70 281 joint T-11 

1il 35 314 joint T-11 

112 90 249 joint T-11 

113 82 264 joint T-11 

114 65 260 joint T-11 

115 85 171 joint T-11 

116 71 208 joint T-11 

117 89 242 joint T-11 

118 12 305 bedding T-11 

119 90 255 joint T-11 

120 64 0 joint T-11 

121 68 70 joint T-11 

122 72 221 joint T-11 

123 84 61 joint T-11 

124 80 164 joint T-11 

125 76 267 fault T-11 

126 81 66 joint T-11 

127 79 6 joint T-11 

128 79 229 joint T-11 

129 77 193 joint T-11 

130 49 274 joint T-12 

131 83 236 joint T-12 

.132 79 20 fault T-12 

133 77 180 joint T-12 

134 79 197 joint T-12 

135 85 1 joint T-12 

136 77 231 joint T-12 

137 55 258 joint T-12 

138 64 175 joint T-12 

139 73 226 joint T-12 

140 88 228 joint T-12 

141 45 213 joint T-12 

142 90 25 joint T-12 

143 67 221 joint T-12 

144 60 158 fault T-12 

145 80 350 fault T-12 

146 76 165 joint T-18 

147 47 245 joint T-18 

148 80 240 joint T-18 

149 88 148 joint T-18
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150 
151 
152 
153 
154 
155 
156 
157 
158 
159 
160 
161 
162 
163 
164 
165 
166 
167 
168 
169 
170 
171 
172 
173 
174 
175 
176 
177 
178 
179 
180 
181 
182 
183 
184 
185 
186 
187 
188 
189 
190 
191 
192 
193 
194 
195 
196 
197 
198 
199 
200 
201 
202 
203 
204 
205 
206

70 
26 
87 
73 
25 
71 
30 
21 
89 
39 
38 
32 
84 
87 
78 
80 
72 
84 
84 
80 
25 
87 
82 
72 
76 
78 
88 
79 
87 
88 
82 
80 
62 
82 
72 
80 
88 
75 
76 
88 
57 
79 
86 
28 
88 
84 
69 
70 
68 
87 
72 
67 
80 
38 
78 
76 
80

237 
235 
300 
228 
230 
232 
218 
225 
231 
247 
230 
227 
215 
210 
105 
192 
98 
270 
325 
268 
234 
210 
275 
320 
40 
245 
88 
257 
1o0 
95 
280 
250 
265 
250 
273 
5 
262 
5 
298 
46 
250 
250 
215 
250 
279 
240 
292 
205 
285 
210 
287 
257 
205 
325 
80 
10 
110

joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
fault 
joint 
joint 
joint 
joint 
joint 
fault 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
fault 
joint 
joint 
joint 
joint

T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18 
T-18
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207 83 5 fault T-18 

"208 88 16 fault T-18 

209 60 282 joint T-18 

210 63 208 26.5 fault T20a 

211 75 11 26.7 fault T20a 

212 68 242 -0.4 joint T20b 

213 53 316 -0.05 joint T20b 

214 72 189 0 joint T20b 

215 69 264 0.1 joint T20b 

216 83 47 0.35 joint T20b 

217 84 261 0.7 joint T20b 

218 82 29 2.3 joint T20b 

219 77 265 2.65 joint T20b 

220 63 264 2.9 joint T20b 

221 59 215 3.15 fault T20b 

222 70 270 3.4 joint T20b 

223 70 48 3.5 joint T20b 

224 62 293 4.2 joint T20b 

225 61 220 7 joint T20b 

226 80 291 7.4 joint T20b 

227 56 286 7.7 joint T20b 

228 82 205 7.9 joint T20b 

229 4 216 7.9 bedding T20b 

230 74 231 7.9 joint T20b 

231 5 208 0 bedding T20c 

232 60 351 1.2 fault T20c 

233 76 176 3.9 fault T20c 

234 68 185 10.2 fault T20c 

235 80 10 11 joint T20c 

236 85 290 11 joint T20c 

237 71 208 0.2 joint T-3 

238 69 261 0.25 joint T-3 

239 74 226 0.45 fault T-3 

240 85 91 0.5 joint T-3 

241 76 261 1.6 joint T-3 

242 76 320 2.4 joint T-3 

243 73 234 3.15 joint T-3 

244 76 20 3.7 joint T-3 

245 90 190 4.5 joint T-3 

246 67 9 5.35 joint T-3 

247 30 206 5.35 joint T-3 

248 79 309 5.35 joint T-3 

249 65 187 5.75 joint T-3 

250 64 240 5.9 joint T-3 

251 74 208 7 fault T-3 

252 60 255 7.2 joint T-3 

253 85 180 7.3 joint T-3 

254 51 248 7.5 fault T-3 

255 66 21 8.4 joint T-3 

256 61 208 8.6 joint T-3 

257 79 218 9 joint T-3 

258 90 205 9.55 joint T-3 

259 62 291 9.6 joint T-3 

260 74 201 9.9 joint T-3 

261 90 269 10 joint T-3 

262 88 275 1.6 joint T-4 

263 85 5 1.7 joint T-4
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264 
265 
266 
267 
268 
269 
270 
271 
272 
273 
274 
275 
276 
277 
278 
279 
280 
281 
282 
283 
284 
285 
286 
287 
288 
289 
290 
291 
292 
293 
294 
295 
296 
297 
298 
299 
300 
301 
302 
303 
304 
305 
306 
307 
308 
309 
310 
311 
312 
313 
314 
315 
316 
317 
318 
319 
320

77 
75 
88 
60 
89 
58 
60 
86 
42 
65 
86 
88 
30 
56 
86 
74 
74 
50 
35 
66 
42 
62 
70 
82 
82 
88 
80 
12 
48 
68 
70 
82 
52 
80 
65 
75 
80 
45 
68 
68 
82 
80 
88 
58 
72 
8 
89 
70 
76 
62 
11 
90 
10 
90 
87 
90 
50

258 
248 
105 
11 
85 
186 
5 
94 
340 
100 
105 
106 
185 
158 
275 
220 
95 
352 
332 
240 
347 
250 
200 
355 
125 
330 
115 
275 
278 
335 
342 
5 
260 
164 
238 
215 
190 
220 
330 
272 
185 
60 
200 
280 
275 
250 
305 
275 
340 
260 
284 
277 
266 
307 
301 
283 
217

1.8 
2 
2.1 
2.15 
2.25 
2.45 
2.5 
2.6 
2.8 
2.92 
3.08 
3.28 
3.28 
3.4 
3.6 
3.78 
3.82 
3.94 
4.1 
4.2 
4.3 
4.5 
4.52 
4 .68 

4.78 
4 .8 
4.9 
4.9 
5.1 
5.48 
5.56 
5.62 
5.92 
6 
6.14 
6.3 
6.4 
6.6 
6.68 
7.02 
7.02 
7.28 
7.32 
7.42 
7.6 
8.02 
8.28 
8.6 
9.12 
9.3 
0.05 
0.05 
1.2 
2.5 
4 
5 
5.4

fault 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
fault 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
fault 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
bedding 
joint 
bedding 
joint 
joint 
joint 
joint

GEO.DCPP.01.22 Rev. 1

T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-4 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5
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321 
322 
323 
324 
325 
326 
327 
328 
329 
330 
331 
332 
333 
334 
335 
336 
337 
338 
339 
340 
341 
342 
343 
344 
345 
346 
347 
348 
349 
350 
351 
352 
353 
354 
355 
356 
357 
358 
359 
360 
361 
362 
363 
364 
365 
366 
367 
368 
369 
370 
371 
372 
373 
374 
375 
376 
377

83 
70 
90 
70 
85 
70 
76 
77 
64 
90 
87 
57 
55 
75 
50 
70 
65 
83 
5 
84 
78 
63 
86 
74 
25 
75 
13 
63 
78 
77 
70 
86 
76 
51 
70 
74 
75 
90 
85 
79 
78 
83 
84 
57 
61 
75 
10 
70 
40 
48 
90 
78 
89 
71 
82 
68 
88

198 
121 
201 
70 
330 
70 
76 
105 
291 
42 
294 
131 
265 
344 
254 
144 
249 
146 
244 
55 
165 
250 
252 
345 
242 
264 
276 
271 
249 
209 
270 
261 
204 
280 
252 
18 
258 
339 
340 
206 
71 
185 
289 
226 
243 
241 
230 
0 
215 
10 
220 
70 
82 
92 
265 
25 
105

5.5 
5.6 
6.7 
7.4 
8.4 
8.5 
8.7 
9.6 
9.9 
10.2 
10.7 
10.9 
11 
11.4 
11.75 
12 
12.2 
12.5 
12.7 
12.8 
13 
13.05 
13.3 
13.6 
14.4 
14 .4 
14.5 
15.3 
15.55 
15.8 
16 
16.3 
16.4 
16.6 
16.8 
16.9 
17.6 
17.9 
18.4 
18.5 
19 
19 
19.1 
19.1 
19.7 
20 

0.64 
0.64 
2.53 
4.02 
4.4 
4.6 
4.98 
5.6 
5.72 
6.28

joint 
joint 
joint 
joint 
fault 
fault 
joint 
joint 
joint 
fault 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
bedding 
joint 
joint 
fault 
joint 
joint 
joint 
joint 
bedding 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
fault 
fault 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
bedding 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
fault 
joint

GEO.DCPP.0 1.22 Rev. I

T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-5 
T-6 
T-6 
T-6 
T-6 
T-6 
T-6 
T-6 
T-6 
T-6 
T-6
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378 82 52 7.26 joint T-6 

379 88 95 7.56 joint T-6 

380 90 310 7.88 joint T-6 

381 62 15 8.72 joint T-6 

382 15 240 8.84 joint T-6 
383 70 6 8.88 joint T-6 

384 88 85 9.4 joint T-6 

385 22 225 9.4 joint T-6 

386 80 255 9.64 joint T-6 

387 84 345 10.08 joint T-6 

388 18 230 10.08 joint T-6 

389 74 75 10.08 joint T-6 

390 72 238 10.36 joint T-6 

391 76 4 10.58 joint T-6 

392 86 190 10.8 joint T-6 

393 78 70 11.08 joint T-6 

394 82 200 11.1 fault T-6 

395 89 265 11.6 joint T-6 

396 78 255 11.8 joint T-6 

397 22 235 11.88 joint T-6 

398 89 180 11.9 joint T-6 

399 85 270 12.06 joint T-6 

400 85 145 12.28 joint T-6 

401 22 235 12.7 bedding T-6 

402 82 70 12.8 joint T-6 

403 80 255 13.76 joint T-6 

404 90 145 13.84 joint T-6 

405 86 46 13.84 joint T-6 

406 16 232 14.02 bedding T-6 

407 78 292 14.02 joint T-6 

408 76 333 14.4 joint T-6 

409 80 290 14.6 joint T-6 

410 78 185 14.8 joint T-6 
411 16 205 15.08 bedding T-6 

412 14 215 15.9 bedding T-6 

413 84 185 16.02 joint T-6 

414 74 245 16.24 joint T-6 
415 78 260 16.6 joint T-6 

416 86 215 16.82 joint T-6 
.417 76 65 17.2 joint T-6 

418 15 204 17.5 bedding T-6 
419 75 250 18.14 joint T-6 

420 14 210 18.24 bedding T-6 

421 75 10 18.4 joint T-6 

* End of File! 
-1
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DIPS input file for Eastcup - NorthEastCut.dip 

* This file is generated by Dips for Windows 
*The following 2 lines are the Title of this file 

Default Title Line 2 
Default Title Line 2 

Number of Traverses: 0 

* Global Orientation is: 

DIP/DIPDIRECTION 

0 (Declination) 

NO QUANTITY 

Number of extra columns are: 3

ID; Dip; Dip Direction;

1 
2 
3 
4 
5 
6 
7 
8 
9 
10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34

40 
18 
74 
48 
67 
66 
41 
40 
44 
48 
72 
71 
64 
51 
64 
72 
79 
75 
76 
67 
69 
85 
81 
63 
68 
45 
66 
72 
67 
8 
10 
3 
78 
61

205 
267 
223 
237 
205 
214 
232 
240 
282 
272 
101 
120 
224 
210 
208 
210 
281 
253 
215 
229 
220 
232 
22 
267 
278 
236 
2 
342 
203 
90 
330 
0 
212 
272

53.453 
50.147 
48.521 
40.597 
39.467 
39.208 
39. 113 
38.731 
35. 604 
34 .321 
27.219 
26.263 
9.438 
79.228 
78.505 
75.4 
66.396 
59.959 
57.898 
54.626 
53.573 
51.698 
36.199 
35.461 
29.089 
25.673 
15.68 
13.177 
9.579 
47 
48 
48.8 
71.79 
70.765

DEPTH; 

joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
joint 
bedding 
bedding 
bedding 
joint 
joint

TYPE; BORING/TRENCH; 

00BA-2 
00BA-2 
00BA-2 
OOBA-2 
00BA-2 
00BA-2 
00BA-2 
OOBA-2 
00BA-2 
OOBA-2 
OOBA-2 
OOBA-2 
OOBA-2 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-E 
01-G 
01-G
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35 46 227 65.647 joint 01-G 
36 68 210 63.781 joint 01-G 
37 70 64 61.594 joint 01-G 
38 69 237 50.116 joint 01-G 
39 67 244 49.801 joint 01-G 
40 67 249 49.303 joint 01-G 
41 78 281 31.327 joint 01-G 
42 58 297 26.302 joint 01-G 
43 31 243 14.083 joint 01-G 
44 72 286 11.392 joint 01-G 
45 63 265 7.867 joint 01-G 
46 13 248 18.7 bedding 01-G 
47 15 192 25.4 bedding 01-G 
48 12 210 29.1 bedding 01-G 
49 63 208 26.5 fault T20a 
50 75 11 26.7 fault T20a 
51 68 242 -0.4 joint T20b 
52 53 316 -0.05 joint T20b 
53 72 189 0 joint T20b 
54 69 264 0.1 joint T20b 
55 83 47 0.35 joint T20b 
56 84 261 0.7 joint T20b 
57 82 29 2.3 joint T20b 
58 77 265 2.65 joint T20b 
59 63 264 2.9 joint T20b 
60 59 215 3.15 fault T20b 
61 70 270 3.4 joint T20b 
62 70 48 3.5 joint T20b 
63 62 293 4.2 joint T20b 
64 61 220 7 joint T20b 
65 80 291 7.4 joint T20b 
66 56 286 7.7 joint T20b 
67 82 205 7.9 joint T20b 
68 4 216 7.9 bedding T20b 
69 74 231 7.9 joint T20b 
70 5 208 0 bedding T20c 
71 60 351 1.2 fault T20c 
72 76 176 3.9 fault T20c 
73 68 185 10.2 fault T20c 
74 80 10 11 joint T20c 
75 85 290 11 joint T20c 
76 71 208 0.2 joint T-3 
77 69 261 0.25 joint T-3 
78 74 226 0.45 fault T-3 
79 85 91 0.5 joint T-3 
80 76 261 1.6 joint T-3 
81 76 320 2.4 joint T-3 
82 73 234 3.15 joint T-3 
83 76 20 3.7 joint T-3 
84 90 190 4.5 joint T-3 
85 67 9 5.35 joint T-3 
86 30 206 5.35 joint T-3 
87 79 309 5.35 joint T-3 
88 65 187 5.75 joint T-3 
89 64 240 5.9 joint T-3 
90 74 208 7 fault T-3 
91 60 255 7.2 joint T-3
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92 85 180 7.3 joint T-3 
93 51 248 7.5 fault T-3 
94 66 21 8.4 joint T-3 
95 61 208 8.6 joint T-3 
96 79 218 9 joint T-3 
97 90 205 9.55 joint T-3 
98 62 291 9.6 joint T-3 
99 74 201 9.9 joint T-3 
100 90 269 10 joint T-3 
101 88 275 1.6 joint T-4 
102 85 5 1.7 joint T-4 
103 77 258 1.8 fault T-4 
104 75 248 2 joint T-4 
105 88 105 2.1 joint T-4 
106 60 11 2.15 joint T-4 
107 89 85 2.25 joint T-4 
108 58 186 2.45 joint T-4 
109 60 5 2.5 joint T-4 
110 86 94 2.6 joint T-4 
11 42 340 2.8 joint T-4 
112 65 100 2.92 joint T-4 
113 86 105 3.08 joint T-4 
114 88 106 3.28 joint T-4 
115 30 185 3.28 joint T-4 
116 56 158 3.4 joint T-4 
117 86 275 3.6 joint T-4 
118 74 220 3.78 joint T-4 
119 74 95 3.82 joint T-4 
120 50 352 3.94 joint T-4 
121 35 332 4.1 joint T-4 
122 66 240 4.2 joint T-4 
123 42 347 4.3 joint T-4 
124 62 250 4.5 joint T-4 
125 70 200 4.52 joint T-4 
126 82 355 4.68 fault T-4 
127 82 125 4.78 joint T-4 
128 88 330 4.8 joint T-4 
129 80 115 4.9 joint T-4 
130 12 275 4.9 joint T-4 
131 48 278 5.1 joint T-4 
132 68 335 5.48 joint T-4 
133 70 342 5.56 joint T-4 
134 82 5 5.62 joint T-4 
135 52 260 5.92 joint T-4 
136 80 164 6 joint T-4 
137 65 238 6.14 joint T-4 
138 75 215 6.3 joint T-4 
139 80 190 6.4 joint T-4 
140 45 220 6.6 joint T-4 
141 68 330 6.68 joint T-4 
142 68 272 7.02 joint T-4 
143 82 185 7.02 joint T-4 
144 80 60 7.28 joint T-4 
145 88 200 7.32 fault T-4 
146 58 280 7.42 joint T-4 
147 72 275 7.6 joint T-4 
148 8 250 8.02 joint T-4
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149 89 305 8.28 joint T-4 
150 70 275 8.6 joint T-4 
151 76 340 9.12 joint T-4 
152 62 260 9.3 joint T-4 
153 51 324 joint T-21 
154 85 353 joint T-21 
155 25 28 joint T-21 
156 44 42 joint T-21 
157 56 7 joint T-21 
158 77 68 joint T-21 
159 71 4 joint T-21 
160 40 331 joint T-21 
161 48 332 joint T-21 
162 20 344 joint T-21 
163 80 40 joint T-21 
164 53 320 joint T-21 
165 77 188 joint T-21 
166 83 314 joint T-21 
167 64 3 fault T-21 

* End of File! 
-i
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DIPS input file for Transport Route Road Cuts - AccessRoadFracs.dip 

* This file is generated by Dips for Windows 
*The following 2 lines are the Title of this file 

Default Title Line 2 
Default Title Line 2 

Number of Traverses: 0 

* Global Orientation is: 

DIP/DIPDIRECTION 

0 (Declination) 

NO QUANTITY 

Number of extra columns are: 3 

ID; Dip; Dip Direction; TYPE; SURFACE; STATION; 

1 90 220 Joint 14 
2 84 44 Joint 6 
3 88 268 Joint 8 
4 67 274 Joint 13 
5 85 240 Joint 7 
6 85 5 Joint 9 
7 84 75 Joint 9 
8 50 2 Bedding 7 
9 80 45 Joint 11 
10 70 135 Joint 9 
11 33 265 Joint 8 
12 78 55 Joint 7 
13 54 344 Bedding 11 
14 4 140 Bedding 
15 35 35 Bedding 
16 45 346 Bedding 6 
17 90 245 Joint 5 
18 42 146 Joint 8 
19 90 244 Joint 8 
20 50 350 Bedding 7 
21 48 142 Joint 8 
22 45 246 Joint 13 
23 46 344 Bedding 6 
24 50 349 Bedding 5 
25 60 264 Joint 5 
26 75 268 Joint 7 
27 28 223 Joint 6 
28 57 356 Bedding 6 
29 66 240 Joint 9 
30 54 155 Joint 8 
31 54 356 Bedding 6 
32 36 157 Joint 6 
33 70 86 Joint 7 
34 51 341 Bedding 4 
35 86 259 Joint 9
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36 41 212 Joint 10 
37 90 258 Joint 8 

* End of File! 
-i
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ATTACHMENT 2 

DIPS Program Verification Runs
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Toppling, Planar Sliding. Wedge Slidng 53 

Toppling, Planar Sliding, Wedge 
Sliding 

This advanced DIPS tutorial uses the example file 
EXAMPPIT.DIP, which you should find in the Examples 
folder of your DIPS Installation folder.  

The data has been collected by a geologist working on a 
single rock face above the first bench in a young open pit 
mine.

.m

position

Local bench 
slopes

Overall pit 
slope (45 
degrees)

The rock face above the current floor of the existing pit 
has a dip of 45 degrees and a dip direction of 135 degrees.  
The current plan is to extend the pit down at an overall 
angle of 45 degrees. This will require a steepening of the 
local bench slopes, as indicated in the figure above.
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54 DIPS Users Guide

The local benches are to be separated by an up-dip 
distance of 16m. The bench roadways are 4m wide.

EXAMPPIT.DIP File

First open the EXAMPPIT.DIP file.

Select File -+ Open 

Navigate to the Examples folder in your DIPS installation 
folder, and open the EXAMPPIT.DIP file. Maximize the 
view.

Figure 4-1: EXAMPPIT.DIP data.  

The EXAMPPIT.DIP file contains 303 rows, and the 
following columns: 

* The two mandatory Orientation Columns 
* A Traverse Column 
* 5 Extra Columns 

Let's examine the Job Control information for this file.
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DIPS .xatwp4 RL .

ID Orient1 Orient2 Traverse SPACING(M) LENGTH(M) TYPE SHAPE SURFACE 
1 77 322 1 3 14 joint planar rough 
2 68 80 1 1.3 7 joint undulate v rouglh 
3 39 136 1 1.6 22 bedding planar smooth 
4 79 319 1 3.8 10 joint iplanar polished 
5 74 85 1 0.7 6 joint Iplanar smooth 
6 70 134 1 1.6 17 joint planar smooth 
7 73 319 1 4.8 14 joint undulate rough~ 
8 83 319 1 1.0 6 joint undulate rou h 
9 65 310 1 2.6 12 joint planar smooth 
10 68 288 1 2.3 10 joint stepped roagh~ 
11 90 265 1 2.1 8 joint planar smooth 
12 76 231 1 1.8 8 joint planar smooth 
13 49 306 1 3.8 21 joint undulate 

14 55 294 1 1.0 8 joint undulate smooth 
15 76 58 1 2.0 i8 joint undulate rough 
16 86 91 1 0.9 6 loint undulate smooth 
17 62 76 1 1.3 7 joint planar rough~ 
18 69 258 1 1.5 :8 joint planar smooth 
19 66 9 1 2.1 7 joint planar rou~lh 
20 69 325 1 2.2 14 joint planar oolished 
21 171 J246 1 1.8 8 joint planar rough 

22 165 53 1 8.0 26 shear planar slick 
23 i37 250 1 2.4 16 joint planar rough 

aa 

24 i78 79 1 3.4 10 joint undulate roh 
25 61 125 1 1.3 17 bedding planar smooth 
26 31 223 1 1.9 15 joint planar v.rough 
27 ,64 249 1 7.0 20 shear planar slick 
28 ;64 40 1 1.0 10 joint stepped smooth 
29 ,66 130 1 1.4 16 joint stepped smooth 
30 55 122 1 1.6 19 bedding planar smooth 
31 74 78 1 3.3 10 joint planar smooth 
32 67 183 1 0.9 7 joint planar rouglh 
33 =69 181 1 0.5 6 joint planar roug~h 
34 !75 6 1 1.9 7 joint undulate smooth 
35 J77 88 1 0.9 6 joint undulate rough 
36 78 169 1 1.2 17 joint undulate rougih 
37 85 76 1 •2.1 8 joint undulate roug]h 
38 64 219 1 1.7 9 joint planar rough 
39 38 179 1 1.9 13 oint undulate smooth 
40 59 176 1 0.5 6 joint undulate rog 
41 77 81 1 1.2 7 joint planar smooth 
42 64 334 1 3.8 17 Ioint planar smooth 
43 51 249 1 6.0 20 shear planar slick 
44 73 272 1 1.4 7 joint undulate v.rouglh 
45 74 176 1 0.9 7 joint planar riouh 
46 66 87 1 1.1 7 joint planar smooth 
47 50 316 1 3.8 21 joint undulate v~roug~h 
48 64 324 1 4.3 13 joint undulate smooth 
49 60 177 1 1.9 ia joint planar rouqt 
50 69 323 1 1.6 11 joint undulate roh 
51 26 32 1 2.7 8_____ oint undulate rough
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ID Orlent1 Orient2 Traverse SPACING(M) LENGTH(M) TYPE SHAPE SURFACE 
52 71 309 1 3.4 17 joint stepped rough 
53 53 321 1 1.0 9 joint planar smooth 
54 89 317 1 3.8 10 joint planar roug•h 
55 68 92 1 1.1 7 joint planar roug•h 
56 54 232 1 2.1 12 joint planar rough 
57 74 183 1 2.4 9 joint undulate rough 
58 60 302 1 2.2 12 joint planar smooth 
59 62 29 1 3.0 9 joint planar smooth 
60 89 311 1 3.0 10 joint planar smooth 
61 77 95 1 0.8 6 joint undulate rough 
62 69 331 1 5.3 18 joint planar smooth 
63 84 328 1 2.2 10 joint planar ro"gh 
64 90 307 1 1.6 7 joint planar rough 
65 73 87 1 0.7 6 joint planar smooth 
66 70 320 1 2.2 10 joint planar smooth 
67 72 36 1 3.8 10 joint planar smooth 
68 88 316 1 3.4 11 joint undulate smooth 
69 79 89 1 3.8 11 joint planar rough 
70 67 187 1 1.6 10 joint planar smooth 
71 55 323 1 4.3 22 joint planar smooth 
72 54 126 1 1.6 19 bedding planar smooth 
73 62 126 1 1.9 19 bedding planar smooth 
74 80 203 1 2.3 9 joint planar rough 
75 73 166 1 0.5 6 joint undulate rough 
76 70 312 1 3.0 16 joint planar smooth 
77 57 338 1 1.9 13 joint undulate smooth 
78 89 68 1 1.5 7 joint undulate rough 
79 82 68 1 0.7 6 joint planar smooth 
80 73 328 1 2.6 10 joint planar rough 
81 62 240 1 1.6 9 joint undulate rougl 
82 66 331 1 1.0 9 joint stepped smooth 
83 49 319 1 1.3 11 joint planar rough 
84 63 79 1 3.0 11 joint planar smooth 
85 43 240 1 10.0 23 shear planar slick 
86 68 171 1 1.2 8 joint planar rough 
87 67 86 1 0.9 7 joint planar rough 
88 76 180 1 0.8 7 joint planar rough 
89 64 316 1 3.4 15 joint planar smooth 
.90 66 317 1 2.6 12 joint planar rough 
91 87 23 1 2.9 8 joint planar rough 
92 75 181 1 0.8 6 joint undulate smooth 
93 88 147 1 3.0 9 joint planar Irough 
94 72 163 1 0.6 6 joint planar roucgh 
95 72 182 1 0.6 6 joint planar smooth 
96 65 91 1 1.9 9 joint planar polished 
97 80 95 1 0.9 6 joint planar rouglh 
98 63 192 1 2.1 9 joint stepped rougih 
99 75 164 1 0.4 6 oint planar smooth 
100 58 321 1 1.0 8 joint planar rough 
101 27 182 1 1.9 15 joint planar rouh 
102 70 169 1 2.1 10 joint planar smooth
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ID Orienti Orient2 Traverse SPACING(M) LENGTH(M) TYPE SHAPE SURFACE 

103 76 231 1 2.2 9 joint undulate rough 
104 84 143 1 1.9 7 joint planar smooth 
105 64 308 1 2.6 12 joint planar roulh 
106 76 47 1 10.0 20 shear planar slick 
107 62 179 1 0.4 6 joint planar rough 
108 77 175 1 2.0 9 joint planar slick 
109 61 322 1 0.7 7 joint planar rough 
110 76 322 1 3.8 16 joint planar rough 
111 78 90 1 1.7 8 joint planar smooth 
112 85 78 1 0.7 6 joint undulate rough 
113 63 97 1 2.7 11 joint stepped rough 
114 80 230 1 2.0 8 joint undulate smooth 
115 68 169 1 0.5 6 joint stepped r"hgh 

116 75 356 1 2.3 11 joint stepped rough 
117 73 168 1 1.1 7 joint stepped rough 
118 72 168 1 0.5 6 joint planar v.rough 
119 85 106 1 1.5 11 joint planar smooth 
120 85 322 1 6.8 17 joint planar rough 
121 60 133 .1 1.3 17 bedding planar smooth 
122 89 317 1 3.4 10 joint planar smooth 
123 88 69 1 5.5 12 joint planar smooth 
124 85 145 1 3.8 10 joint planar smooth 
125 69 45 1 2.2 8 joint planar rough 
126 81 331 1 1.9 7 joint planar rough 
127 65 331 1 1.9 11 joint planar v.rough 
128 67 235 1 2.2 10 joint undulate smooth 
129 71 146 1 2.0 18 joint planar rough 
130 73 331 1 1.3 8 joint stepped rough 
131 79 83 1 0.9 6 joint planar rough 
132 49 140 1 1.6 20 bedding planar smooth 
133 58 279 1 2.8 14 joint planar smooth 
134 84 214 1 1.7 7 joint planar v.rough 
135 83 75 1 1.0 6 joint planar rouglh 
136 75 74 1 1.9 8 joint undulate v.rough 
137 70 177 1 1.0 7 joint planar smooth 
138 50 253 1 6.0 23 shear planar slick 
139 65 38 1 1.9 8 joint planar rough 
140 70 86 1 3.0 11 joint planar smooth 
141 53 323 1 3.0 17 joint planar v.rough 
142 45 23 1 2.3 8 joint stepped smooth 
143 58 14 1 1.8 7 joint undulate rough 
144 46 28 1 2.0 8 joint planar v.rough 
145 67 88 1 2.1 9 joint stepped smooth 
146 53 317 1 2.2 14 joint planar v.rough 
147 77 93 1 0.9 6 joint planar polished 
_148 56 333 1 6.3 30 joint planar v.rough 
149 58 303 1 2.6 13 joint planar smooth 

150 62 307 1 1.3 9 joint stepped v.rough 
151 72 320 1 1.3 6 joint planar polished 
152 76 174 1 0.5 16 joint undulate rough 
153 57 176 1 1.5 19 joint planar v.rough
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ID Orientl Orient2 Traverse SPACING(M) LENGTH(M) TYPE SHAPE SURFACE 
154 66 160 1 2.3 11 joint undulate smooth 
155 60 336 1 0.7 8 joint planar v.roulh 
156 70 178 1 0.6 6 joint planar polished 
157 89 321 1 3.0 9 joint planar smooth 
158 72 87 1 2.6 10 joint planar Mrough 
159 176 34 1 2.6 8 joint planar rouglh 
160 64 321 1 2.2 9 joint undulate v.rough 
161 79 85 1 5.4 14 joint planar v.rough 
162 76 166 1 0.6 6 joint planar v.rough 
163 52 269 1 1.9 12 joint planar v.rough 
164 73 325 1 3.0 8 joint planar v.uh 
165 81 74 1 0.8 6 joint undulate Iv.rough 
166 61 176 1 1.1 8 joint undulate rough 
167 76 83 1 0.9 6 joint planar rough 
168 82 69 1 1.7 7 joint planar rough 
169 33 303 1 1.8 15 joint planar rough 
170 81 169 1 2.0 8 joint planar smooth 
171 58 330 1 4.3 21 joint planar vMrough 
172 79 172 1 1.4 7 joint planar rough 
173 68 187 1 0.4 6 joint planar rough 
174 30 272 1 2.0 16 joint planar rough 
175 75 67 1 1.1 7 joint stepped rough 
176 79 38 1 8.0 25 shear planar slick 
177 68 176 1 1.5 8 joint planar v.rough 
178 64 321 1 1.6 8 joint planar smooth 
179 58 189 1 2.4 12 joint planar rough 
180 74 48 1 1.9 8 joint planar smooth 
181 89 317 1 1.6 7 joint planar smooth 
182 66 309 1 1.0 7" joint planar smooth 
183 86 322 1 3.0 10 joint stepped smooth 
184 60 109 1 1.4 16 joint stepped rough 
185 72 327 1 3.8 13 joint planar slick 
186 61 38 1 1.9 8 joint planar v.rough 
187 75 320 1 6.3 20 joint planar rough 
188 73 81 1 0.9 6 joint planar v.r"hoh 
189 54 338 1 2.2 15 joint planar v.rough 
190 82 332 1 1.9 7 joint planar v.rough 
191 72 82 1 1.9 8 joint planar v.rough 
192 54 126 1 1.9 20 bedding planar smooth 
193 86 267 1 1.8 7 joint planar rough 
194 51 311 1 2.6 16 joint planar rough 
195 68 319 1 4.3 16 joint undulate rough 
196 74 73 1 2.6 9 joint planar rouglh 
197 39 58 1 2.6 10 joint stepped rough 
198 67 72 1 2.5 9 joint stepped smooth 
199 71 82 1 0.8 6 joint planar smooth 
200 30 225 1 1.2 11 joint undulate smooth 
201 79 62 1 5.2 12 joint undulate dmooth 
202 73 331 1 1.9 9 joint undulate smooth 
203 80 319 1 1.9 7 joint undulate smooth 
204 25 181 1 2.0 16 joint planar ;smooth
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ID Orienti Orlent2 Traverse SPACING(M) LENGTH(M) TYPE SHAPE SURFACE 
205 59 246 1 1.7 10 joint planar smooth 
206 64 43 1 0.4 6 oint planar smooth 
207 73 315 1 0.4 6 joint planar rough 
208 74 48 1 4.3 11 joint undulate smooth 
209 69 94 1 1.0 7 joint planar rough 
210 86 45 1 2.2 7 ioint planar smooth 
211 55 318 1 4.3 22 joint undulate rough 
212 61 323 1 3.8 17 joint planar rough 
213 52 139 1 1.1 17 joint undulate smooth 
214 63 129 1 1.0 15 bedding planar smooth 
215 89 326 1 3.8 16 joint undulate smooth 
216 83 164 1 3.6 10 joint planar smooth 
217 78 72 1 1.9 8 joint planar smooth 
218 70 117 1 1.4 16 joint planar smooth 
219 67 349 1 1.7 10 joint planar smooth 
220 63 123 1 1.7 18 bedding planar smooth 
221 64 1 1 2.4 14 joint undulate vrough 
222 56 330 1 2.2 14 joint planar rough 
223 14 317 1 1.6 13 joint planar v.rough 
224 69 158 1 0.6 6 joint planar smooth 
225 63 115 1 1.3 16 bedding planar smooth 
226 81 36 1 3.8 9 joint planar smooth 
227 47 119 1 1.5 19 bedding planar smooth 
228 79 164 1 0.6 6 joint planar smooth 
229 70 102 1 1.1 7 joint planar smooth 
230 61 162 1 0.7 7 joint stepped rough 
231 66 178 1 0.6 7 joint planar rough 
232 56 133 1 1.0 16 joint undulate rough 
233 71 85 1 3.0 10 joint planar rough 
234 54 153 1 1.8 7 joint Planar rough 
235 54 119 1 0.9 15 joint undulate rough 
236 61 327 1 3.4 17 joint planar rough 
237 65 173 1 0.5 6 joint undulate rough 
238 78 80 1 2.1 8 joint stepped rough 
239 52 293 1 1.3 10 joint undulate smooth 
240 70 266 1 1.6 8 joint planar rough 
241 51 119 1 1.7 20 bedding planar smooth 
242 63 176 1 1.0 8 joint planar rough 
243 62 343 1 1.7 11 joint planar smooth 
244 73 325 1 3.4 14 joint planar v.rough 
245 61 306 1 3.8 17 joint planar smooth 
246 51 137 1 1.7 20 bedding planar smooth 
247 73 328 1 1.9 10 joint planar smooth 
248 84 83 1 0.9 6 joint planar smooth 
249 73 318 1 2.6 10 joint planar smooth 
250 179 89 1 2.6 9 joint planar smooth 
251 77 322 1 3.8 14 joint planar smooth 
252 85 144 1 4.3 10 joint undulate rough 
253 56 308 1 3.0 16 joint planar rough 
254 53 122 1 1.0 16 joint planar vough 
255 57 269 1 1.8 11 joint planar smooth
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ID Orient1 Orient2 Traverse SPACING(M) LENGTH(M) TYPE SHAPE SURFACE 

256 85 145 1 1.9 7 joint undulate v.rough 

257 64 77 1 5.4 15 joint undulate smooth 

258 53 112 1 1.2 16 joint undulate rough 
259 70 32 1 3.8 10 joint planar smooth 
260 89 68 1 2.1 8 joint undulate roagth 
261 54 126 1 2.1 21 bedding planar smooth 

262 74 332 1 2.2 9 joint undulate rough 

263 36 273 1 1.8 14 joint planar rough 
264 67 48 1 2.2 8 joint planar roug•h 

265 43 342 1 0.7 9 joint planar rough 

266 39 266 1 10.0 20 shear planar slick 
267 72 272 1 2.2 9 oint undulate rough 
268 66 170 1 1.1 9 joint planar rough 

269 84 154 1 1.6 11 oint planar rouhg 

270 75 319 1 3.4 13 joint planar smooth 

271 87 327 1 4.8 20 oint planar smooth 

272 77 218 1 1.9 8 oint undulate smooth 

273 67 79 1 0.8 7 oint stepped smooth 

274 81 332 1 3.8 10 joint undulate rough 

275 62 321 1 6.3 25 oint planar smooth 
276 68 348 1 1.6 10 joint undulate v.rough 

277 88 327 1 2.6 13 joint undulate smooth 
278 66 91 1 0.9 7 joint planar rough 

279 61 221 1 1.6 9 joint planar polished 
280 75 172 1 1.6 8 joint planar rough 
281 79 164 1 0.5 6 joint planar rough 
282 70 320 1 4.3 15 joint planar rough 

283 51 312 1 5.8 29 joint planar smooth 
284 60 262 1 1.9 10 joint planar smooth 
285 84 313 1 0.4 6 joint planar smooth 
286 79 38 1 3.4 9 joint planar smooth 

287 64 176 1 3.0 12 joint planar polished 
288 64 289 1 3.0 13 joint planar smooth 
289 87 142 1 2.6 9 joint planar rough 
290 75 69 1 1.7 8 joint stepped v.rough 
291 39 264 1 6.0 19 shear planar slick 
292 74 78 1 1.1 7 joint planar rough 
293 171 98 1 0.9 7 joint planar smooth 
294 75 24 1 1.3 6 joint undulate rough 

295 78 88 1 1.9 8 joint planar smooth 
296 66 172 1 2.0 10 joint planar smooth 
297 77 311 1 1.9 8 joint planar smooth 

298 84 313 1 3.8 14 joint planar polished 
299 66 9 1 2.0 7 joint planar smooth 
300 87 296 1 1.0 6 joint planar rough 
301 67 71 1 2.6 9 joint planar rouqh 
302 79 73 1 2.5 9 joint planar smooth 

303 °88 1 1 1.5 7 joint planar rough
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Observe the clustering of 
Joint, bedding and shear 
features on a Symbolic Pole 

SPlot.

* b.dWIISI

�n

Use Add Plane to add a great 
circie representing the pit 
slope on the stereonet. I

Figure 4-3: Symbolic Pole Plot of discontinuity TYPE. Great circle 
representing the pit slope has also been added.  

In the above figure, you will notice that a great circle has 
been added to the plot, representing the pit slope.  

Planes are added to stereonet plots with the Add Plane 
option, as described below.  

Add Plane 

Before we add the plane, let's change the Convention. In 
DIPS, orientation coordinates can be displayed in either 
Pole Vector (Trend/Plunge) format, or Plane Vector 
format. Right now we want to use the Plane Vector 
Convention, which for this file is DIP/DIPDIRECTION, 
since this is the Global Orientation Format.

GEO.DCPP.01.22 Rev. 1

57

Look closely at the data clustering and the data TYPE.  
Note the clustering of bedding features and the two 
dusters of shear features. These may behave very 
differently from similarly oriented joints or extension 
fractures, and should be considered separately.

ptit N- - - 1, '. "-- 7.  
C.-
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Now let's view the contoured data.  

Select View -+ Contour Plot

Figure 4-5: Unweighted Contour Plot of EXAMPPIT.DIP data.  

A useful rule of thumb is that any cluster with a 
maximum concentration of greater than 6% is very 
significant. 4-6% represents a marginally significant 
cluster. Less than 4% should be regarded with suspicion 
unless the overall quantity of data is very high (several 
hundreds of poles). Rock mechanics texts give more 
rigorous rules for statistical analysis of data.  

Now let's apply the Terzaghi Weighting to the data, to 
account for bias correction due to data collection on the 
(planar) traverse.  

Select View -+ Terzaghi Weighting

GEO.DCPP.0 1.22 Rev. I

Contour Plot
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Fisher 
Concentrations 

% of total per 1.0 % area 

0.00- 1.00% 

1.00- 2.00% 2.00 - 3.00 % 

3.00- 4.00% 
4.00- 5.00% 
5.00- 6.00% 
6.00- 7.00% 

..-.. -7.00- 8.00% 
8.00- 9.00% 
9.00 -10.00% 

No Bias Correction 
Max, Conc. - 7.6705% 

Equal Anr•e 
Lower Herisphere 

303 Poles 
303 Entries

S
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To overlay contours, let's first view the Pole Plot again.  

Select View -+ Pole Plot 

Note that the Symbolic Pole Plot is still in effect, and does 
NOT get reset when you switch to viewing other plot 
types (eg. the Contour Plot). To overlay contours: 

Select View -+ Overlay Contours 

Let's change the Contour Mode to Lines, so that the Poles 
are easier to see.  

Select Setup -+ Contour Options 

In the Contour Options dialog, set the Mode to Lines and 
select OK.  

I - . - .

Figure 4-7: Overlaid Contours on Pole Plot

GEO.DCPP.01.22 Rev. 1
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Alhog theSERarno nunemus enough to be 
rePl'sentedo n th contours, 
they may have a dominating' 
influence on stabilit due to 

low fricton angles and

Notice that the Shears in this example are not represented in the contours. This is because the number of mapped shears is small. However, due to the low friction angle and inherent persistence, the shear features may have a dominating influence on stability. It is always important to look beyond mere orientations and densities when analyzing structural data.

Creating Sets

V~

GEO.DCPP.0 1.22 Rev. 1

Now use the Add Set Window option to delineate the joint contours, and create four Sets from the four major data concentrations on the stereonet.  

Select: Sets --+ Add Set Window 

See the Quick Tour of DIPS, the first tutorial in this manual, for instructions on how to create Sets. Also see the DIPS Help system for detailed information.

. r 

3,? 

U.q 

a. 7 .  

L

Figure 4-8: Set Windows formed around the four principal joint 
sets, using the Add Set Window option.  
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Figure 4-12: Variability cones displayed on Pole Plot.  

Toppling 

(The following analysis is based on Goodman 1980. See 
the reference at the end of this tutorial).  

Using the variability cones generated above, .proceed with 
a toppling analysis. Assume a friction angle of 35 degrees, 
based on the surface condition of the joints (see Figure 4
10).  

Planes cannot topple if they cannot slide with respect to 
one another. Add a second plane representing a "slip 
limit" to the stereonet with the Add Plane option.  

Select Select -+ Add Plane 

Position the cursor at APPROXIMATELY 10 / 135 (Dip/ 
DipDirection) and click the left mouse button.

GEO.DCPP.0 1.22 Rev. 1

I- VIM 

* -1
w + ,, [-M 

Je:d't

+ • t, L~~+

A TOPPLING ANALYSIS 
using stereonets is based on.  

1) Variability cones 
indicating the extent of, 
the joint set population.  

2); A SlipLimit based on the 
joint friction angle and pit 
slope.  

3) Kinematic 
considerations.
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!'w: oft Select OK on the Add Cone dialog.  

The zone bounded by these new curves (outlined in Figure 
4-13 below) is the toppling region. Any Poles plotting 

Q• within this region indicate a toppling risk. Remember that I a near horizontal pole represents a near vertical plane.  

The zone outlined in "Il 

Figure 4-13 is the toppling I .", 
w ~~region. Any POLES plottn 

within this region indicate a 

Figuren4r13:.oppling risk is in btertivn umbersof 

I rein Vsa estimate indicates t a bot 25- 30% oftethopplngtiskafo 
-poultio o joint set 4,fabasediton the t5%pvriabiityzone. I 

could be said thato ignoring variability in the friction 

rangle, there is an approximate toppling risk of 30%.  jFrictional variability could be introduced by overlaying 
puadditional slip limits corresponding to say 30 and 40 

j: ) •degrees.  

.!rm)
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Lower Hemisphere 
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ripe ~ 
_ 

I 

1,111011 that a POLE friction 
cone angle is measured from ! ,i. Ithe center of the stereonet.  

~JR 
I 

2M (em I 
Figure 4-15: Planar sliding Zone is represented by crescent shaped region. Only a small area overlaps the bedding joint set, therefore the risk of planar sliding is minimal.  

Again, the variability cones give a statistical estimate of E failure probability. Only a small percentage ( < 5 % ) of the bedding joint set falls within this zone.  

Planar sliding is unlikely to be a problem.  

NOTE: We have been using EQUAL ANGLE projection throughout this analysis. When making visual estimates of clusters and variabilities, it is actually more 
appropriate to use EQUAL AREA projection to reduce areal distortion and improve visual estimates. E 

Wedge Sliding 

It has been shown that a sliding failure along any of the Cft joint planes is unlikely. However, multiple joints can form wedges which can slide along the line of intersection a " between two planes. 1 I 
Ia 

O .
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Note that a PLANE friction 
cone angle is measured from 
the perimeter (equator) of the 

stereonet.

NOTE: this time we are not dealing with poles but an 
actual sliding surface or line, so that the friction angle (35 
degrees) is taken from the EQUATOR of the stereonet, 
and NOT FROM THE CENTER as before. Therefore the 
angle we enter in the Add Cone dialog is 90 - 35 = 55 
degrees.

Select OK, and your plot should appear as follows:

WEDGE SLIDING may occur 
if the mean joint set 

oanentation INTERSECTIONS 
Wal within the zone defined by 
the friction cone and the pit 

slope.

SPL0f 0R!C10N CONE

1 o<l~5 5 

1 n 070 I81 

O n so~3 
3 a?5 t as 

3 Sr4 ,In 

4 I 011,321 
A OF031328 

2 057 1123 
2 U . 1 0 131

303 P0I 
303 E 

Figure 4-16: Major Planes Plot showing WEIGHTED MEAN planes, 
pit slope and friction cone. Wedge sliding zone is represented by 
crescent shaped region. Since no plane intersections (black dots) 
fall within this region, wedge sliding failure should not be a 
concern.
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4 
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ID Dip / Direction 
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w 
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w 
m 
w 
m 
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069 I 180 
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057 1133 
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075 1 89 
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Getting Started 

Getting Started 

• •DIPS is designed to work on Windows 95, 98 and 
Windows NT 4.0 operating systems.  

To install DIPS on your computer: 

1. Insert the CD-ROM.  

2. Setup should begin automatically displaying the main 
'. &Rocscience Installation window.  

• 'a• 3. If not, select Add / Remove Programs from the Control 
Ai Panel and click on the Install button. Follow the 

S: .directions until the main Rocscience Installation 
window is displayed.  

4. Click on the DIPS button.  

5. Click on the INSTALL FULL VERSION button.  

6. Follow the installation instructions. During 
installation you will be asked to enter your seventeen 
character alphanumeric serial number. Enter the 
serial number located on the outside of the CD case to 
install the program. Proceed until the installation is 

11 .complete and you are back to the Rocscience 
Installation window.  

7. Click on the RETURN button.  

8. If you have NOT previously installed the hardlock 
- •driver software for any other Rocscience program 

proceed with step 9. Otherwise go to step 13.  

9. Click on the HARDLOCK button.  

10. Click on the INSTALL DRIVER FOR 95,98,NT 
button.  

"1 .  

'I
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11. Proceed until the hardlock driver installation is 
complete and you are back to the Rocscience 
Installation window.  

12. Click on the RETURN button.  

13. Click on the EXIT button. ft-

14. To run DIPS, you will also need the hardlock supplied 
with the program. The hardlock must be attached to 
the parallel port on your computer during execution of " 
the program. Attach the DIPS hardlock to the parallel I 
port of your computer.  

15. The installation process creates a ROCSCIENCE 
menu in your START... PROGRAMS menu. In the .• 
ROCSCIENCE menu there will be a DIPS menu 
containing the DIPS application. Run the DIPS I 
application.  

16. If you are a first time user, follow the "Quick Tour of . i 
DIPS" and "Creating a DIPS File" tutorials presented 
in this manual, to get acquainted with the basic 
features of DIPS.  

am. vn so 
fin
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* Introduction 
* DIPS is a program designed for the interactive analysis of 

orientation based geological data. The program is a tool S• kit capable of many different applications and is designed 
both for the novice or occasional user, and for the 

S-. •accomplished user of stereographic projection who wishes 
to utilise more advanced tools in the analysis of geological 
data.  

* -• DIPS allows the user to analyse and visualise structural 
data following the same techniques used in manual • •stereonets. In addition, many computational features are 
available, such as statistical contouring of orientation • clustering, mean orientation calculation and qualitative 
and quantitative feature attribute analysis.  

DIPS has been designed for the analysis of features 
related to the engineering analysis of rock structures, 
however, the free format of the DIPS data file permits the "* a analysis of any orientation based data.  

S.Aboutthis Manual 

This manual consists of the following tutorials: 

1. Two basic tutorials, to get new users acquainted with 
-•the basic features of the program: 

. )•> Quick Tour of DIPS 

) Creating a DIPS File 

2. Two advanced tutorials, to show how DIPS can be 
used for various types of analyses, which may not 

-.have been obvious without illustration: 

> Toppling, Planar Sliding, Wedge Sliding 
) Oriented Core and Rockmass Classification 

a_:.  

- a 
v' 

a'

GEO.DCPP.01.22 Rev. I
December 14, 2001Page 86 of 168



Calculation 52.27.100.732, Rev. 0, Attachment B, Page • of 90 

.4 DIPS User's Guide 

This manual is intended as a hands-on, getting started 
user's guide. For more information on any DIPS options 
which are not discussed in these pages, consult the DIPS 
Help system.  

NOTE that the example files used in this manual, and 
provided with the DIPS program, are intended for use in " 
training and education only. They should not be used as 
data sets for research. , 

In this manual, instructions such as: 

Select: View-- Pole Plot 

are used to navigate the menu selections.  

When a toolbar button is displayed in the margin, as 
shown above, this indicates that the option is available in -.  

a DIPS toolbar. This is always the recommended and 
quickest way to use the option. 3 

, = 

is..
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Quick Tour of Dips

This "quick tour" will familiarize the user with some of 
the basic features of DIPS.  

If you have not already done so, run DIPS by double
clicking on the DIPS icon in your installation folder. Or 
from the Start menu, §elect Programs -+ Rocscience -+ 

Dips -+ Dips.  

If the DIPS application window is not already maximized, 
maximize it now, so that the full screen is available for 
viewing the data.

EXAMPLE.DIP File

In your DIPS installation folder you will find an Examples 
folder, containing several example DIPS files. This Quick 
Tour will use the EXAMPLE.DIP file in the Examples 
folder. To open the EXAMPLE.DIP file:

GEO.DCPP.01.22 Rev. 1

a

a 

a 

a 

a

wi a 

a 

a 

a

U

- a 

U 

a 

* a 

a

"9.
U 

a 

m 

S 

a

Page 88 of 168 December 14, 2001



Calculation 52.27.100.732,.Rev. 0, Attachment B, Page _x of 90

6 DIPS User's Guide

Select: File -+ Open 

Navigate to the Examples folder in your DIPS installation 
folder, and open the EXAMPLE.DIP file.  

You should see the spreadsheet view shown in Figure 2-1.  
A DIPS file is always opened by displaying a spreadsheet 
view of the data. The DIPS spreadsheet is also called the 
Grid View throughout this manual. Maximize the Grid 
View.

Figure 2-1: Grid View of EXAMPLE.DIP file.  

We won't worry about the details of this file yet, except to 
note that it contains 40 rows, and the following columns: 

* Two Orientation Columns 
* A Quantity Column 
* A Traverse Column 
* Three Extra Columns 

In the next tutorial, we will discuss how to create the 
EXAMPLE.DIP file from scratch.
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Creating a Pole Plot is just one mouse click away. Select 
the Pole Plot option in the View toolbar or the View menu.  

Select: View -+ Pole Plot 

A new view displaying a Pole Plot will be generated, as 
shown below.  

r ~ ~kot ...............

Figure 2-2: Pole Plot of EXAMPLE.DIP data.  

Each pole on a Pole Plot represents an orientation data 
pair in the first two columns of a DIPS file.  

The Pole Plot can also display feature attribute 
information, based on the data in any column of a DIPS 
file, with the Symbolic Pole Plot option. This is covered 
later in this tutorial. I.t
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I11Wike IDip ~ght ',j245

Convention 

As you move the cursor around the stereonet, notice that 
the cursor orientation is displayed in the Status Bar.  

The format of these orientation coordinates can be toggled 
with the Convention option in the Setup menu: 

" If the Convention is Pole Vector, the coordinates will 
be in Trend / Plunge format, and represent the cursor 
(pole) location directly. This is the default setting.  

" If the Convention is Plane Vector, the coordinates will 
correspond to the Global Orientation Format of the 
current document (eg. Dip/DipDirection, 
Strike/DipRight, Strike/DipLeft), and represent the 
PLANE corresponding to the cursor (pole) location.  

TIP- the Convention can be quickly toggled by clicking on 
the box in the Status Bar to the left of the coordinate 
display, with the LEFT mouse button. This is the quickest 
and most convenient way of toggling the Convention.  

The Convention also affects the format of certain data 
listings in DIPS (eg. the Major Planes legend, the Edit 
Planes and Edit Sets dialogs), and the format of 
orientation data input for certain options (eg. Add Plane 
and Add Set Window dialogs).  

Finally note that in DIPS, poles are ALWAYS plotted 
using the Trend and Plunge of the pole vector with 
respect to the reference sphere. THE CONVENTION 
OPTION DOES NOT AFFECT THE PLOTTING OF 
DATA, OR THE VALUES IN THE GRID IN ANY WAY!! 

Legend 

Note that the Legend for the Pole Plot (and all stereonet 
plots in DIPS) indicates the: 

* Projection Type (Equal Angle) and

GEO.DCPP.01.22 Rev. I
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9 Hemisphere (Lower Hemisphere).  

These can be changed using Stereonet Options in the 
Setup menu (Equal Area and Upper Hemisphere options 
can be used). However, for this tutorial, we will use the 
default projection options.  

Note that the Legend also indicates "61 Poles, 40 Entries".  

" The EXAMPLE.DIP file has 40 rows, hence "40 
entries".  

" The Quantity Column in this file allows the user to 
record multiple identical data units in a single row of 
the file. Hence the 40 data entries actually represent 
61 features, hence "61 poles".  

Let's move on to the Scatter Plot.
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While the Pole Plot illustrates orientation data, single 
pole symbols may actually represent several unit 
measurements of similar orientation.  

Select the Scatter Plot option in the View toolbar or the 
View menu, to generate a Scatter Plot.  

Select: View -- Scatter Plot 

A Scatter Plot allows the user to better view the 
numerical distribution of these measurements, since 
coincident pole and closely neighbouring pole 
measurements are grouped together with quantities 
plotted symbolically. The Scatter Plot Legend indicates 
the number of poles represented by each symbol.  

Let's move on to the Contour Plot, which is the main tool 
for analyzing pole concentrations on a stereonet.

Scatter Plot
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Contour Plot

Select the Contour Plot option from the View toolbar or 
the View menu, and a Contour Plot will be generated.  

Select: View -- Contour Plot

Figure 2-3: Contour Plot of EXAMPLE.DIP data.  

The Contour Plot clearly shows the data concentrations. It 
can be seen that there are three data clusters in the 
EXAMPLE.DIP file, including one that wraps around to 
the opposite side of the stereonet.  

Since this file only contains 40 data entries, the data 
clustering in this case was apparent even on the Pole Plot
"However, in larger DIPS files, which may contain 
hundreds or even thousands of entries, cluster recognition 
will not necessarily be visible on Pole or Scatter Plots, and 
Contour Plots are necessary to identify major data 
concentrations.
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• •Weighted Contour Plot 

Since this file contains Traverse information (Traverses 

are discussed in the next tutorial), a Terzaghi Weighting 

* can be applied to Contour Plots, to correct for sampling 

bias introduced by data collection along Traverses.  
a 

To apply the Terzaghi Weighting to the Contour Plot: 

. Select: View -> Terzaghi Weighting 

Note the change in the Contour Plot. Applying the 

*" Terzaghi Weighting may reveal important data 

concentrations which were not apparent on the 
unweighted Contour Plot. The effect of applying the 

Terzaghi Weighting will of course be different for each 

* file, and will depend on the data collected, and the 

traverse orientations.  
a 

DO NOT USE WEIGHTED CONTOUR PLOTS FOR 

-" APPLICATIONS UNLESS YOU ARE FAMILIAR WITH 

THE LIMITATIONS. For a discussion of sampling bias 

- and the Terzaghi Weighting procedure, see the DIPS Help 

system.  

To remove the Terzaghi Weighting and restore the 

unweighted Contour Plot, simply re-select the Terzaghi 

Weighting option.  

Z Select: View -- Terzaghi Weighting 

Contour Options 

Many Contour Options are available allowing the user to 

customize the style, range and number of contour 

* intervals. We will not explore the Contour Options in this 

Quick Tour, however, the user is encouraged to 

experiment. Contour Options is available in the Setup 

menu, or by right-clicking on a Contour Plot.  

T
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Stereonet Options 

At this point, let's examine the Stereonet Options dialog, 

which configures the basic stereonet parameters for the 

Contour Plot and all other stereonet plots in DIPS.  

Right-click on the Contour Plot and select Stereonet 

Options, or select Stereonet Options from the Setup 
menu.

-stroe Options
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Figure 24: Stereonet Options dialog.  

If you examine the Contour Plot legend, you will notice 
that all of the Stereonet Options are recorded here, 
including the Distribution method (Fisher in this case) 
and the Count Circle size (1% in this case) used to obtain 
the contours. Select Cancel to return to the Contour Plot.  

See the Stereonet Options topic in the DIPS Help system, 
for complete details about all of the DIPS Stereonet 
options.
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Another widely used technique for representing 
orientations is the Rosette Plot.  

The conventional rosette plot begins with a horizontal 
plane (represented by the equatorial (outer) circle of the 
plot). A radial histogram (with arc segments instead of 
bars) is overlain on this circle, indicating the density of 
planes intersecting this horizontal surface. The radial 
orientation limits (azimuth) of the arc segments 
correspond to the range of STRIKE of the plane or group 
of planes being represented by the segment. In other 
words, the rosette diagram is a radial histogram of strike 
density or frequency.  

To generate a Rosette Plot, select Rosette Plot from the 
View toolbar or the View menu.  

Select: View -+ Rosette Plot 

7, -7. 4

Although the default Rosette 
Plot uses a horizontal base 

plane, an arbitrary base plane 
at any orientation can be 
specified in the Rosette 

Options dialog. For a non
horizontal base plane, the 
Rosette Plot represents the 
APPARENT STRIKE of the 
lines of intersection between 

the base plane and the planes 
in the DIPS file.

Figure 2-5: Rosette Plot of EXAMPLE.DIP data.
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Rosette Applications 

The rosette conveys less information than a full stereonet 
since one dimension is removed from the diagram. In 
cases where the planes being considered form essentially -
two dimensional geometry (prismatic wedges, for 
example) the third dimension may often overcomplicate 
the problem. A horizontal rosette diagram may, for 
example, assist in blast hole design for a vertical bench 
where vertical joint sets impact on fragmentation. A I 
vertical rosette oriented perpendicular to the axis of a 
long topsill or tunnel may simplify wedge support design I 
where the structure parallels the excavation. A vertical 
rosette which cuts a section through a slope under - I 
investigation can be used to perform quick sliding or L M , 
toppling analysis where the structure strikes parallel to 
the slope face.  

From a visualisation point of view and for conveying (a 
structural data to individuals unfamiliar with 
stereographic projection, rosettes may be more ' 

appropriate when the structural nature of the rock is I 
simple enough to warrant 2D treatment.  

Weighted Rosette Plot 

The Terzaghi Weighting option can be applied to Rosette - ,l 
Plots as well as Contour Plots, to account for sampling 
bias introduced by data collection along Traverses.  

"* If the Terzaghi Weighting is NOT applied, the scale of 
the Rosette Plot corresponds to the actual "number of .  
planes" in each bin.  

"* If the Terzaghi Weighting IS applied, the scale of the 
Rosette Plot corresponds to the WEIGHTED number 
of planes in each bin.  

Do not use weighted plots for applications unless you are 
familiar with the limitations. See the DIPS Help system 
for more information.
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. Adding a Plane 

The Add Plane option allows the user to graphically add a 

a =pole / plane to a stereonet plot (Pole, Scatter, Contour or 
Major Planes plots).  

First let's switch the plot type back to a Contour Plot, 
since planes cannot be added on the Rosette Plot.  

[ j Select: View -- Contour Plot 

. iNow select Add Plane from the Select toolbar or the Select 
menu.  

a-: Select: Select - Add Plane 

"1. Move the cursor over the Contour Plot. When the 
, •cursor is INSIDE the stereonet, an arc or "great circle" 

representing the plane corresponding to the cursor 
S:•location (pole) will appear. Move the cursor around 

the stereonet, and observe the position of the 
. &corresponding plane.  

2. Note that the cursor coordinates are visible in the 
status bar. When the plane / pole is at a desired 

-. orientation, click the LEFT mouse button INSIDE the 

stereonet. (Remember that the coordinate Convention 
* &can be toggled in the Status Bar).  

. 3. The Add Plane dialog will appear, allowing you to 

modify the graphically entered orientation (if 
necessary), and also provide ID, labeling (optional) 
and visibility information.  

U 

For this example, enter ID = 1, Label =planel, and leave 
the Visibility checkboxes at their default selections. Select 
OK.  

, t The plane I pole will be displayed on the plot, according to 
the visibility settings chosen, as shown in Figure 2-7.
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r.] -P

If the graphically entered 
orientation is not correct, then 

simply enter the correct 
values in the Add Plane 

"dialog.

in i ~~~hej Fplanel 

",:RE~jLNG F0 : -132~ 

Pr ~z 
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Figure 2-6: Add Plane dialog.  

NOTE: The visibility settings that you choose in the Add 
Plane dialog can be modified AT ANY LATER TIME in 
the Edit Planes dialog.  

:b.lam ~ i. 4~1 _ 07~..4

Figure 2-7: Added plane / pole displayed on Contour Plot.  

NOTE: planes created with the Add Plane option in DIPS 
are referred to as ADDED PLANES, to distinguish them 
from MEAN PLANES calculated from Sets. (Sets and 
mean planes are discussed in the next section).
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I Creating Sets

A Set as defined in DIPS, is a grouping of data created 
with the Add Set Window option. The Add Set Window 
option allows the user to draw windows around data 
clusters on a stereonet, and obtain mean orientations of 
data (poles) within the windows.

Before we go further, note the following:

"* The windows created with Add Set Window are 
curvilinear four-sided windows, defined by two trend 
values and two plunge values at opposite corners.  

"* The windows are always formed in a CLOCKWISE 
direction, therefore you must always START a Set 
Window with one of the COUNTER-CLOCKWISE 
corners.  

Let's create our first Set with the small data cluster at the 
right side of the stereonet.

Select: Sets --> Add Set Window

1. Locate the cursor at APPROXIMATELY Trend/Plunge 
= 55 / 65, and click the LEFT mouse button.  
Remember that the cursor coordinates are displayed 
in the Status Bar.  

2. Move the mouse in a CLOCKWISE direction, and you 
will see a curvilinear, four-sided Set Window opening 
up.  

3. Move the cursor to APPROXIMATELY Trend/Plunge 
= 115 / 20, and click the LEFT mouse button. You will 
then see the Add Set Window dialog.
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Figure 2-8: Add Set Window dialog.

4. Don't worry if the window coordinates are not exactly 

those shown above, as long as the window encloses the 

desired data. However, you may edit the coordinates 

at this time, if you wish.  

5. We will accept the default Set ID and Visibility 

settings, so just select OK, and the Set will be created.

Figure 2-9: Set Window and Unweighted mean pole / plane 
displayed for Set 1.
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* A Set Column is automatically 
added to the Grid when the 

FIRST Set is created.

Mean Plane Display 

When a Set is created, you will notice the following on the 

stereonet, as shown in Figure 2-9: 

"* The Set Window will be displayed.  

" The mean pole / plane will be displayed according to 

the visibility settings chosen in the Add Set Window 

dialog. In this case, we have displayed the 

Unweighted mean pole vector and plane.  

"* Unweighted mean poles / planes are identified by an 
"im" beside the Set ID. Weighted mean poles / planes, 

if displayed, are identified by a "w" beside the Set ID.  

Status Bar Display 

After a Set is created, the Status Bar will display the 

number of poles in the Set. For this example, the Status 
Bar should now show: 

10 poles from 8 entries in Set 1 [ 

The "8 entries" refers to the number of rows of the grid 

within the Set. Since we have a Quantity Column in this 

file, each row can represent multiple data units (poles). In 

this case, the 8 rows actually represent 10 poles.  

Set Column 

When the FIRST Set is created, a Set Column is 

automatically added to the Grid. The Set Column records 

the Set ID of data belonging to Sets. Let's verify this.  

Return to the Grid View (you may select from the list of 

open views in the Window menu).  

* Notice the Set Column, which appears AFTER the 

Traverse Column.

3.
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* Notice the data in the Set Column which is flagged 
with the Set ID = 1. These are the poles within the Set 
Window just created.  

Now return to the Contour Plot view, and we will create 

another Set, this time with a window which wraps around 

the perimeter of the stereonet.  

Wrapped Set Windows 

After you have selected the FIRST corner of a Set Window 

with the Add Set Window option, you will notice that if 

the cursor moves beyond the stereonet perimeter, it will 

"wrap around" and re-appear on the opposite side of the 

stereonet, with the window still attached.  

This allows data near the perimeter, on opposite sides of 

the stereonet, to be selected as one Set, as illustrated in 

Figure 2-10.

WRAPPED SET WINDOW

A wrapped Set Window in 
DIPS automatically calculates 

the correct mean vector for 
Sets which cross the equator.

Figure 2-10: Wrapped Set Window.
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This useful feature of DIPS automatically calculates the 
correct mean vector for Sets with poles plotting on 

opposite sides of the equator, since A MEAN 

ORIENTATION CALCULATED FROM THE LOWER 

HEMISPHERE ALONE WILL BE INCORRECT!! 

The poles within a wrapped Set window that plot on the 

opposite side of the stereonet, are incorporated into the 
vector addition AS NEGATIVE poles (ie. plunge = 

plunge , trend = trend + 180), so that the mean will be 

correctly calculated.  

Let's create a second Set using a wrapped Set Window.  

Select Sets -+ Add Set Window 

1. Locate the cursor at APPROXIMATELY Trend/Plunge 
= 300 / 20, and click the LEFT mouse button.  

Remember that the cursor coordinates are displayed 
in the Status Bar.  

2. Move the cursor to the stereonet perimeter, and you 

will see that the Set Window reappears on the 
opposite side of the stereonet.  

3. A wrapped Set Window may seem awkward at first, 
but is very simple once you get the hang of it. At 

worst, if you seem to "lose control", right-click the 

mouse and select Cancel, and start again! 

4. Move the cursor to APPROXIMATELY Trend/Plunge 
= 170 / 20, and click the LEFT mouse button. You will 
see the Add Set Window dialog.
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5. Don't worry if the window coordinates are not exactly 
those shown above, as long as the window encloses the 
desired data. However, you may edit the coordinates 
at this time, if you wish.  

6. We will accept the default Set ID (2 in this case) and 
Visibility settings, so just select OK, and the Set will 
be created.

0 to w*c Ra v'-GO O Lqoq ~ a~ea 9 kgoý;OQw

Frm 

0.00- 250% 

S, so- 500% 

1000-12 50% E 12 W- 15 00 

1571- % 

7o0- 2000% 
20 0D- 22 50% 
22 50 250% 

M. CCO, 23 29 31% 

E". Ano.  

61 P"S.  
40 E0s'

I-

Figure 2-11: Set Windows and Unweighted mean poles / planes 
displayed for Sets 1 and 2.
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Figure 2-12: Set Windows and Unweighted mean poles I planes 
displayed for Sets 1i, 2 and 3.
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As when we created the first Set, note that the Set 

Window and Unweighted mean pole / plane are displayed.  

Also, the Status Bar should read (if you selected all of the 

poles on both sides of the stereonet): 

22 poles from 15 entries in Set 2 

Finally, note that the Set Column in the Grid View is 

updated to record the data in both Sets 1 and 2. Note that 

data which does NOT currently belong to any Set has a 

BLANK entry in the Set Column.  

Now create a third Set Window around the remaining 

data concentration on the Contour Plot. (A Set Window 

with corners at approximately Trend I Plunge = 190 / 40 

and Trend / Plunge = 235 / 3 will do the job).
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Set Information 

Let's now look at the Info Viewer option, which provides a 
summary of your DIPS file, as well as a listing of all 
Added Planes (Add Plane option), and all Set information.  

[Select: File -+ Info Viewer
i-
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Figure 2-13: Info Viewer display of Set information.  

As you scroll through the Info Viewer, you will see: 

0 your DIPS file setup information, 

* Global mean vector orientation (ie. the mean vector of 
all poles in the file), and 

* a list of Added Planes, if any exist (you should see the 
single plane listed, which we added earlier in this 
tutorial).  

"If Sets have been created, you will then see: 
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I

1. A listing of Unweighted and Weighted MEAN plane 
orientations for each Set, in both Pole Vector (Trend I 
Plunge) and Plane Vector format.  

2. A listing of Set Statistics (Fisher coefficient, and 
Confidence and Variability Limits at one, two and 
three standard deviations).  

3. The Set Window limits (ie. the two corners defining 
each Set Window, in Trend / Plunge format).  

Confidence and Variability cones can be displayed on 
stereonet plots, as discussed in Tutorial 3.  

The Info Viewer listing can be printed, copied to the 
clipboard, etc. The Info Viewer behaves like any other 

view in DIPS (ie. it can be tiled, minimized, maximized, 
etc.), and is automatically updated whenever new 

information is added to the current document (eg. when a 

new Set is created). When you are finished examining the 

Info Viewer, close the view by selecting the x button in the 
upper right corner.
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Major Planes Plot

The Major Planes Plot option in DIPS allows the user to 
view PLANES ONLY on a clean stereonet, without poles 
or contours. In addition, a listing of plane orientations is 
displayed in the legend, in the format governed by the 
current Convention (Trend / Plunge or Plane Vector).  

Select View -+ Major Planes 

The following PLANES are displayed on a Major Planes 
Plot: 

* All ADDED planes created with the Add Plane option 

a All MEAN planes for Sets created with the Add Set 
Window option 

w o... . . .. . . . . . . .. a.l

Figure 2-14: Major Planes Plot.  

Only planes / poles toggled for Visibility in the Edit 
Planes and Edit Sets dialogs, will be displayed on the 
Major Planes Plot.
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In Figure 2-14 we have toggled off the display of Set 
Windows. This is done with the Show Windows option in 

* the Sets menu, which toggles the visibility of the Set 
Windows on a per view basis. Let's do that now.  

Select: Sets - Show Windows 

Major Planes Legend 

.5 The Major Planes legend displays the orientations of 
planes in the format governed by the Convention (Trend I 

- Plunge or Plane Vector). Remember that the Convention 
can be toggled at any time in the Status Bar, and will 
automatically update the planes Legend. Also note: 

* The letter "m" beside a plane ID indicates an 
UNWEIGHTED MEAN PLANE for a Set 

*, * The letter "w" beside a plane ID indicates a 
WEIGHTED MEAN PLANE for a Set 

* A Plane ID with NO letter indicates an ADDED plane 
created with the Add Plane option.  

For our current example, we have one ADDED plane 

(Added Planes are always listed first in the legend), 
followed by the MEAN planes for the three Sets.  

Plane Colours 

.. The default colours used for planes in DIPS are: 

S"-- GREEN for all ADDED planes 

* RED for all MEAN planes 

The user can customize ADDED plane colours in the Edit 
~. .*• Planes dialog, and MEAN plane colours in the Edit Sets 
. " dialog. This is left as an optional exercise. NOTE that 

i• • unlike most other display options in DIPS, changes to the L 

Plane Colours (or the Plane Visibility settings) affect ALL 
views for the current document, and are NOT 

- customizable on a per view basis.  

Cu ° 

.S.
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Working with Multiple Views

New stereonet plot views can be generated at any time, by 
selecting the New Plot View option in the Window menu.  
Let's generate two new plot views, so that we can view 
different plots at the same time.  

Select Window -+ New Plot View 

By default, a Pole Plot is always displayed when a new 
plot view is generated in this manner. Generate one more 
view.  

Select Window --. New Plot View 

Now tile the views.

E�i Select: Window -- Tile Vertically

Your screen should now display: 

* Two Pole Plot views 

* A Major Planes Plot view 

* The Grid View.  

Click on one of the Pole Plot views, to make it the active 
view, and display a Rosette Plot.  

Select View -* Rosette Plot 

Click on the Major Planes Plot, to make it the active view, 

and display a Contour Plot.  

Select View - Contour Plot 

Your screen should now look something like the following 
figure:

C -.  

r ftwI 

IU~ 

I.  

4"•
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a
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Figure 2-15: Tiled display of four views, EXAMPLEDIP file.  

._, , .

; " We will now briefly demonstrate how display options in •DIPS are customizble on a per view basis.  

FigCustomizing Views o 

First we will hide the planes and Set Windows on the Pole 

Plot View.  

Show Planes 

The Show Planes option can be used to Show or Hide 

planes on a PER VIEW basis.  

Click the mouse in the Pole Plot view, to make it the 
active view. Now select Show Planes.  

S] Select Select -+ Show Planes 

Notice that ALL planes on the Pole Plot view are now .  

hidden. However, the Set Windows are still displayed.

GEO.DCPP.01.22 Rev. 1
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Show Windows , 

To hide the Set Windows: -.  

Select Sets -- Show Windows 

The Set Windows on the Pole Plot view are now hidden.  

(As an optional step, click in the Contour Plot view and 
select Show Windows, to re-display the Set Windows in 
this view). e .  

This demonstrates how planes and Set Windows can be cal.  

shown or hidden on a PER VIEW basis.  

Display Options 

Now let's look at the Display Options dialog. Right-click I
on the Pole Plot view, and select Display Options. 0 aii 

* In the Display Options dialog, change the Stereonet 
colour to WHITE, and select OK. - I

Right-click on the Rosette Plot and select Display Options. I 

* In the Display Options dialog, change the Background 
colour to BLACK and change the Legend Text colour 
to WHITE. Select OK. r .

This demonstrates how colours can be customized on a 
PER VIEW basis.  

NOTE that favourite viewing options (all Display Options, L ' 
Stereonet Options, and Contour Options), can be saved by - I 
the user with Auto Options in the Setup menu. Saved 
options can be re-applied to individual views at a later 
time, or saved as the program defaults, allowing the user e ai 

to create their own customized version of DIPS.  

,wd •-:'..
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Symbolic Pole Plot

We will now demonstrate how feature attribute analysis 
can be carried out using the Symbolic Pole Plot and Chart 
options in DIPS.  

First, maximize the Pole Plot view.  

1. Right-click on the Pole Plot and select Symbolic Pole 
Plot (Symbolic Pole Plot is also available in the View 
menu).  

2. In the Symbolic Pole Plot dialog, change the Plot Style 
to Symbolic Pole Plot.  

3. In the drop-down list, select the column you would 
like to plot. For example, select TYPE.

'-1, 

.7.  

IF.

Figure 2-16: Symbolic Pole Plot dialog.
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4. The data in the TYPE column is Qualitative, therefore 
we do not have to change the Data Type (if the data 
were Quantitative, ie. numeric, then we would have to 
select the Quantitative Data Type option).  

5. Notice that a list of all entries in the TYPE column 
appears in the Allocated list area.  

6. Select OK, and a Symbolic Pole Plot will be generated, 
displaying symbols corresponding to the entries in the 
TYPE column.

Figure 2-17: Symbolic Pole Plot of data in the TYPE column.  

Symbolic Pole Plot Legend

In the Symbolic Pole Plot legend, you will notice a number 
in square brackets beside each label being plotted. This 
refers to the TOTAL number of poles with that label (ie. it 
accounts for the Quantity Column values). If you add the 
numbers in the square brackets, you will find that the 
total is equal to the number of Poles listed at the bottom 
of the legend, in this case, 61.
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Creating a Chart from a Symbolic Plot 

Now let's create a corresponding Histogram, based on our 
Symbolic Pole Plot.  

1. Right-click on the Symbolic Pole Plot and select 
Create Corresponding Chart.  

2. A new chart view will automatically be generated, 
using the same data and settings selected for the 
Symbolic Pole Plot.

Figure 2-18: Histogram corresponding to Symbolic Pole Plot.  

The Chart can then be customized, if necessary, by right
clicking on the Chart and selecting Chart Properties (eg.  
the Histogram can be converted to a Pie Chart or a Line 
graph).  

"Of course, Charts can be generated directly using the 
Chart option in the Select menu, the above procedure is 

simply a shortcut for generating a chart from an existing 
Symbolic Pole Plot.

m
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Query Data 

To wrap up this Quick Tour, we will demonstrate how to 
quickly and easily create subset files from a DIPS file, 
using the Query Data option.  

Select: Select -). Query Data 

You will see the Query Data dialog.

I Quer Daa 3

r:Evresson' • 

S~~~~~~~~~~~~~~~~~~. . . . .. .......... ... ,................... C. ... . . • ••,• • .:•-•:;-. . .! ,':::• 

~OpCancer 

Figure 2-19: Query Data dialog.  

Query Data allows the user to create any sort of logical 
expression to query the information in any column, or any 

combination of columns, of your DIPS file.  

Lts first create a simple query which searches for all 
JOINTS with a ROUGH surface, ie.: 

TYPE = joint && SURFACE Includes rough
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"Query Example I 

The first step in creating a query, is to create an 
Expression. As you can see at the top of the Query Data 

dialog, an Expression consists of Data, Operator and 
Operand.  

1. In the Query Data dialog, click in the Data box at the 
left of the Expression area, and select TYPE from the 
drop-down list.  

2. Click in the Operand box, and select "joint" from the 
drop-down list.  

-• a 3. The Expression area should now display TYPE - , 
: 7i%, joint.  

To create the query, use the buttons at the left of the 
a •Create Query area to enter the desired expression(s) in 

the area to the right of the buttons.  

4. Select the Expression button in the Create Query 
: •area. This will enter the expression TYPE - joint in 

the Create Query area.  

5. Select the AND button to enter the logical && 
operator.  

a 6. Now create the Expression SURFACE Includes rough.  

' 7. Select the Expression button.  

. 8. Select OK.  

- A new DIPS file should immediately be generated, and a 

new Grid view will display the selected data. For the 

, =EXAMPLE.DIP file, this query should create a new file 
with 13 rows.  

Note that: 

a0 

S" "i• i
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"* All entries in the TYPE column are "joint".  

"* All entries in the SURFACE column "include" the 
string "rough"- "sl.rough", "rough" and "v.rough'.  

This example also demonstrates the use of the "Includes" 
operator, which finds all entries "including" the substring 
entered as Operand in the Expression.  

The New File 

The new file created after a query is also a DIPS file, with 
all of the same Job Control and Traverse information as 
the original file.  

You can immediately start working with this file. For 
example: 

Select: View -+ Pole Plot 

to generate a Pole Plot of the new subset. Any DIPS 
option can now be carried out on the new file, including 
another query.  

If you want to preserve the new file, it is recommended 
that you save the file with an appropriate name, before 
proceeding with further analysis.  

What About the Set Column? 

Earlier in this tutorial, we created Sets with the Add Set 
Window option. When Sets are created in DIPS, a Set 
Column is automatically added to the Grid. You will 
notice in the new file created after a Query, that the Set 
column is preserved.
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1r 

However, note that the Set Column in the new file merely 
"preserves the Set ID information. ALL OTHER SET 
INFORMATION (ie. MEAN PLANES, WINDOW LIMITS, 
SET STATISTICS etc.) IS NOT TRANSFERRED TO 
THE NEW FILE. SETS, AS DEFINED IN DIPS, DO NOT 
"EXIST IN THE NEW FILE CREATED AFTER A 

*. QUERY.  

.lQuery Example 2 

If you followed through Query Example 1, then first click 
in any view of the original EXAMPLE.DIP file, so that you 
can create another query using this file.  

• ,As a final step in this Quick Tour of DIPS, we will 
demonstrate how to create a new file from a Set, using 
Query Data. .  

Since the Set Column records the Set ID of data belonging 
to Sets, this is simply a matter of querying the Set 
Column for the desired ID(s).  

"Select: Select - Query Data 
.ýXr 1.  

1. In the Query Data dialog, create the Expression Set 
2: & ~= 1. : 

Z 

2. Select the Expression button.  

S.3. Select OK.  

. .You should now be looking at a new Grid view, containing 
only the data in Set 1. Notice that all of the data in the 

. -., SET Column of the new file = 1, as we would expect.  

. :This demonstrates how easily new files can be created 
from Sets in DIPS using Query Data.  

,•- •.

-:, ,
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Verify that the new Grid contains the Set 1 data, by 
creating a Pole Plot, and comparing with the Sets you 
created in the EXAMPLE.DIP fle. The poles in the new 
file should correspond to the poles within the Set Window 
for Set 1.  

More Query examples can be found in the DIPS Help 
System. That concludes this Quick Tour of DIPS.
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Creating a DIPS File 
-_ UJ

•,- :-In this tutorial we outline the steps necessary to create 
S... " "the EXAMPLE.DIP file, which you will be familiar with if 
.• .. •you followed the Quick Tour of DIPS in the previous 

• i: chapter. ; 

•-- : ~If you have not already done so, run DIPS by double-.'.  
:2 .& clicking on the DIPS icon in your installation folder. Or 
[:• ~from the Start menu, select Programs --* Rocscience -+>• 

•- = ~Dips -+ Dips. ""• 

• : " If the DIPS application window is not already maximized, • 
!,• _ ~maximize it now, so that the full screen is available for ;: 

S..... mviewing the data.  

, - U: 

tELEXAMPLEPDIP File 

Since we will be re-creating the EXAMPLE.DIP fiby le t's 
- first examine this file.  

SR6 

~~ 
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If you have already taken the Quick Tour of DIPS in the 
previous chapter, then proceed on to the next section 
(New File).  

If you have NOT taken the Quick Tour, then open the 
EXAMPLE.DIP file, which you will find in the Examples 
folder in your DIPS installation folder.  

A DIPS file is always opened by displaying a Grid View 
(spreadsheet) of the data. Maximize the Grid View.

Figure 3-1: Grid View of EXAMPLE.DIP file.  

Notice that this file contains the following columns: 

* Two Orientation Columns 
• A Quantity Column 
* A Traverse Column 
* Three Extra Columns 

When you have finished examining the EXAMPLE.DIP 
data, close the file, and we will discuss how to re-create 
this file from scratch.
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To begin creating a new DIPS file, select New from the 
File menu or the Standard toolbar.  

Select: File -+ New 

You will see the following blank DIPS spreadsheet, which 
contains: 

* Two Orientation Columns 
* 100 rows

Figure 3-2: Grid View of New File.  

If you have not already, maximize the Grid View.  

As you can see from the titles of the two Orientation 
Columns, the default Global Orientation Format for a 
New file is DIP/DIPDIRECTION. For this example, we 
need to change this to STRIKE/DIP (right hand rule).  
This is done through the Job Control option.
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Job Control 

When creating a new DIPS file, you will generally need to 
use the Job Control option before proceeding to enter 
data.  

Select: Setup -4 Job Control

Job Cotrol E

* 4 -

Figure 3-3: ,Job Contl dialog.  

For this example, we need to configure the: 

"• Global Orientation Format 
"* Declination 
"r Quantity Column 

Global Orientation Format 
The Global Orientation Format in the Job Control dialog 
determines how DIPS will interpret the data in the two 

Orientation Columns.

'1 L 
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Mixed orientation formats 
can be combined in the 

"same DIPS file by using the 
Traverse Orientation Format

a 

al

... �- 

� 
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For this example, most of our data is in STRIKE/DIP 
(right hand rule) format, so change the Global Orientation 
Format to STRIKE/DIPR.  

NOTE: Mixed orientation formats CAN BE COMBINED 
IN THE SAME DIPS FILE by using the optional Traverse 
Orientation Format, described later in this tutorial.  

Declination 

Enter a Declination of-5.5.  

The Declination is typically used to correct for magnetic 
declination, but can be used to adjust to grid north.  

Note that the declination is ADDED to all azimuth values, 
therefore a POSITIVE value corrects for WEST 
declination, and a NEGATIVE value corrects for EAST 
declination (which is the case in this example).  

Quantity Column 

A Quantity Column in a DIPS file allows the user to 
record single data entries which refer to multiple identical 
features having the same orientation.  

Select the Quantity Column checkbox in the Job Control 
dialog.  

We are now done with the Job Control dialog. Select OK, 
and note the following changes to the spreadsheet: 

"* The titles of the two Orientation Columns are now 
Strike (Right) and Dip.  

" A Quantity Column has been added to the 
spreadsheet. For convenience, the Quantity Column 
values are initially set to 1 when the column is 
created. The user can enter higher values as 
necessary (eg. 2, 3, 4...)

N-

I-
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Figure 3-4: Quantity Column added to spreadsheet.

Traverses

Traverses are used to group data units, and are also used 
by DIPS to weight the data to correct for measurement 
bias. To define Traverses: 

Select: Setup -* Traverses 

You will see the Traverse Information dialog. The 
EXAMPLE.DIP file uses four Traverses, so select the Add 
button four times.
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Figure 3-5: Traverse Information dialog.  

Enter the following information for the four Traverses.  

ID Format Type Or1 Or2 Or3 Comment 

1 STRIKE/ LINEAR 120 30 Traverse I 
DIPR 

2 STRIKE/ PLANAR 100 10 Traverse 2 
DIPR 

3 BORE 20 145 120 Traverse 3 
HOLE 

4 DIP/ PLANAR 10 190 Traverse 4 
DIPDIRECTION 

Table 3-1: Traverse Information for EXAMPLE.DIP file.  

Traverse ID 

The Traverse ID can be any integer value greater than 0.  
Each Traverse must have its own unique ID.  

Traverse Orientation Format 

The Traverse Orientation Format is very important, 
because it allows the user to combine mixed orientation 
formats in the same DIPS file.
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Whenever the Traverse Orientation Format is different 
from the Global Orientation Format, DIPS will interpret 
the orientation data for the Traverse according to the 
Traverse Orientation Format.  

In this example: 

" l Traverses I and 2 have the same data format as the 
Global Orientation Format (STRIKEIDIPR).  S12 

"* Traverse 3 is a BOREHOLE traverse. The Traverse 
Orientation Format is not applicable, since data is 
measured in terms of alpha and beta angles on the 
oriented core. See the DIPS Help system for detailed Ip 
discussion of BOREHOLE traverses.  

" Traverse 4 uses a different orientation format from 
the Global Orientation Format. In this case, the data 
on Traverse 4 is in DIP/DIPDIRECTION format.  

Traverse Type 

Four Traverse Types are available in DIPS: 

* LINEAR 
• PLANAR 

* BOREHOLE 
* CLINORULE 

Traverse Orientation 

The orientations required to define the Traverse 
Orientation depend on the Traverse Type, and may also L 
depend on the Traverse Orientation Format.  

* Traverse 1 is a LINEAR traverse. For a LINEAR 
traverse, the Orient 1 and Orient 2 values are always 
in TREND/PLUNGE format.
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. Traverse 2 is a PLANAR traverse. For a PLANAR 

"traverse, the Orient 1 and Orient 2 values correspond 
. to the Traverse Orientation Format, in this case 

STRIKE/DIPR.  

Traverse 3 is a BOREHOLE traverse, which requires 
': THREE orientations to define. See the DIPS Help 

system for details.  

.. Traverse 4 is a PLANAR traverse. In this case, the 
Traverse Orientation Format is DIP/DIPDIRECTION, 
therefore the Orient 1 and Orient 2 values are in 

• "DIP/DIPDIRECTION format.  

Traverse Comment 
An optional Traverse Comment can be added for each 

Traverse, to further identify / describe each traverse.  ~ :m 

You may inspect the original EXAMPLE.DIP file to view 
the comments added for these four traverses.  

Traverse Column 

When you are finished entering the Traverse Information, 
select OK, and you will see that a Traverse Column has 
been added to the spreadsheet, after the Quantity 
Column.  

To The Traverse Column is for recording the Traverse ID of 
each data unit. In this case, 1, 2, 3 and 4.  

V -Also notice that the titles of the two Orientation Columns 

-•are now Orient 1 and Orient 2, instead of StrikeR and 

Dip. Since there are mixed orientation formats in this 
data file (remember that the Traverse Orientation Format 

for Traverse 4 is DIP/DIPDIRECTION while the Global 
- .Orientation Format is STRIKE/DIPR), the titles of the 

Orientation Columns are simply Orient 1 and Orient 2, to 
avoid misinterpretation of the data.  
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Figure 3-6: Traverse Column added to spreadsheet.

Extra Columns

In DIPS, any columns AFTER the two mandatory 
Orientation Columns, and the optional Quantity and 
Traverse Columns (if present), are referred to as Extra 
Columns.  

Extra Columns can be used to store any other 
QUANTITATIVE or QUALITATIVE data that the user 
wishes to record.  

Recall that the EXAMPLE.DIP file used three Extra 
Columns: 

* SPACING 

TYPE 
• SURFACE 

Extra Columns are added to the DIPS spreadsheet with 
the Add Column option in the Edit menu.  
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Q ,Add Column 

-; Since Extra Columns can only be added AFTER the 
Orientation, Quantity and Traverse Columns, the current 
highlighted spreadsheet cell must be either: 

* IN AN EXISTING EXTRA COLUMN, or 

- * IN THE LAST OF THE ORIENTATION, QUANTITY, 
OR TRAVERSE COLUMNS, AS APPLICABLE, 

in order for the Add Column option to be enabled.  

In this case, since no Extra Columns currently exist, click 
- the mouse in the Traverse Column. The Add Column 

- option will be enabled.  

Select: Edit --+ Add Column 

You will see the Add Column dialog, allowing you to enter 
. - the column name. Enter the name SPACING,M: 

Column Name.'\~ san 

Figure 3-7: Add Column dialog.  

-The title of Extra Columns Select OK to add the Extra Column. Notice that the title 

always displayed in of Extra Columns is always displayed in UPPERCASE, 
- UPPERCASE. regardless of how the name was actually entered in the 

Add Column dialog.  

Now let's add the TYPE and SURFACE Extra Columns.  
An alternative way to add an Extra Column, is to RIGHTCLICK on the title of an existing Extra Column, or the 

* - LAST of the Orientation, Quantity or Traverse columns, 
as applicable. For example:
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1. Right-click the mouse on the title of the SPACING,M r 
column which you just created.  

2. Select Add Column from the right-click menu.  

3. Enter the name TYPE in the Add Column dialog, and 
select OK, and the TYPE Extra Column will be added 'arz 

to the spreadsheet.  

4. Now right-click the mouse on the title of the TYPE I 
column.  

5. Select Add Column from the right-click menu. Q 

6. Enter the name SURFACE in the Add Column dialog, 
and select OK, and the SURFACE Extra Column will 
be added to the spreadsheet.  

Congratulations! You have now re-created all of the 1k, 
columns of the EXAMPLE.DIP file. You are now ready to 11- .  

start entering data.  

..... ...... ....... .. . .  

S... _ _ _ ..... _...... _ -... . . ..... _... . . . . . . . ... .. : ; . .• !.-:,-, , 

1:4

Figure 3-8: Three Extra Columns added to spreadsheet. C _ 
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Q 

..'. 

.'.V 

.I 

47:

To conclude this tutorial, we will: 

"* Open the EXAMPLE.DIP file, and copy the data into 
our new file.  

"* Generate Pole Plots for both files, and hopefully they 
will be identical! 

Select: File -* Open 

Navigate to the Examples folder in your DIPS installation 
folder, and open the EXAMPLE.DIP file. Tile the two 
views.  

Select: Window -+ Tile Horizontally 

1. In the EXAMPLE.DIP spreadsheet, click on the ID 
button at the upper left corner, to select the entire 
spreadsheet.  

2. Right-click the mouse anywhere in the 
EXAMPLE.DIP spreadsheet and select Copy.  

3. Now left-click the mouse in the FIRST cell of the new 
spreadsheet (ie. the Row 1 , Orient 1 cell).  

4. Right-click the mouse anywhere in the new file 
spreadsheet, and select Paste.  

5. The data from the EXAMPLE.DIP file should now be 
pasted into the new file.  

6. Let's verify that we have correctly re-created the 
EXAMPLE.DIP file.  

Select View -- Pole Plot

GEO.DCPP.01.22 Rev. I
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7. This will generate a Pole Plot of the data in the new 

file.  

8. Now click the mouse anywhere in the EXAMPLE.DIP , 
spreadsheet, to make it the active view.  

Select View -+ Pole Plot 

9. This will generate a Pole Plot of the EXAMPLE.DIP 
file.  

10. Tile the views.  

"Select: Window -- Tile Vertically 

11. Compare the two Pole Plots. They should be identical.  
If not, then examine the Job Control and Traverse it 
dialogs of the new file, and make sure they are the .  
same as the EXAMPLE.DIP file. Also check that the 6 : 

data in the new file ends at the fortieth row, since the 
EXAMPLE.DIP file contained forty rows.  

That concludes this tutorial. If you wish you can save the 
new file, and then read it back in again. Notice that the 
blank rows after the fortieth row are no longer present 
after saving the file.  

S•I,...  

4I 

:1 ..  
ei i
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Toppling, Planar Sliding, Wedge 
Sliding 

This advanced DIPS tutorial uses the example file 
EXAMPPIT.DIP, which you should find in the Examples 
folder of your DIPS Installation folder.  

The data has been collected by a geologist working on a 
single rock face above the first bench in a young open pit 
mine.

aI

Current floor 
position

Local bench 
slopes

Overall pit 
slope (45 
degrees)

V

4 

V
The rock face above the current floor of the existing pit 
has a dip of 45 degrees and a dip direction of 135 degrees.  
The current plan is to extend the pit down at an overall 
angle of 45 degrees. This will require a steepening of the 
local bench slopes, as indicated in the figure above.
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The local benches are to be separated by an up-dip 
distance of 16m. The bench roadways are 4m wide.

EXAMPPIT.DIP File

First open the EXAMPPIT.DIP file.

Select: File -> Open 

Navigate to the Examples folder in your DIPS installation 
folder, and open the EXAMPPIT.DIP file. Maximize the 
view.  

S . .......... ... ,l .2l ~ 22

Figure 4-1: EXAMPPIT.DIP data.  

The EXAMPPIT.DIP file contains 303 rows, and the 
following columns: 

* The two mandatory Orientation Columns 
* A Traverse Column 
• 5 Extra Columns 

Let's examine the Job Control information for this file.
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Job Control 

Select: Setup - Job Control 

ý'ProjeqTit-# 

J, Surfatce Structure Survey - #3 Pit Slope -B F.O.P MINE 
M.Diederichs 11/07/92 Surveyed on bench plane at 

ýDe~atSetup 

diol6Sajbi'ieno' Forrt' -I.DIP/DIPDIRECTION ' 
Fige 4:oentatio n Fom atEXAMPPIT.DIP f 

-Declination (degrees, West .ve)' j 

j, O-uantr~y'Coiumn 

Traverse~s 

Figure 4-2: Job Control information for EXAMPPIT.DIP file.  

Note the following: 

" the Global Orientation Format is 

DIP/DIPDIRECTION 

" The Declination is 7.5 degrees, indicating that 7.5 

degrees will be added to the dip direction of the data, 

to correct for magnetic declination 

" The Quantity Column is NOT used in this file, so each 

row of the file represents an individual measurement.  

Traverses 

Let's inspect the Traverse Information. You can select the 

Traverses button in the Job Control dialog (the Traverses 

dialog is also available directly in the Setup menu).
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As you can see in the Traverse Information dialog, this I 
file uses only a single traverse: 

a The Traverse is a PLANAR traverse, with a DIP of 45 
degrees and a DIP DIRECTION of 135 degrees (ie. the 
face above the survey bench, as you can read in the 3 
Traverse Comment). ' a , 

Note that the Traverse Orientation Format is the -.  

same as the Global Orientation Format 5 
(DIP/DIPDIRECTION), as we would expect for a file 6 
with only a single traverse defined. 3..  

Select Cancel in the Traverse Information dialog.  

Select Cancel in the Job Control dialog. ¶ 
"Pole Plot 

Now generate a Pole Plot of the data. -I 
Select: View-- Pole Plot 

Feature attribute analysis can be carried out on a Pole 
Plot with the Symbolic Pole Plot option. Let's create a 
Symbolic Pole Plot based on the discontinuity type (ie. the 
data in the TYPE column). l.  

Right-click on the Pole Plot and select Symbolic Pole Plot.  
In the Symbolic Pole Plot dialog: 1 

1. Change the Plot Style to Symbolic Pole Plot, and 
select TYPE from the pull-down list of column names. 'i 

2. The Data Type for this column is Qualitative, which is 
the default selection, so just select OK to generate the .  

Symbolic Pole Plot.  

Li
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Observe the clustering of 
joint bedding and shear 
"features on a Symbolic Pole 

Plot.

-4.

Use Add Plane to add a great 
circle representing the pit 
slope on the stereonet.

1�

Figure 4-3: Symbolic Pole Plot of discontinuity TYPE. Great circle 
representing the pit slope has also been added.  

In the above figure, you will notice that a great circle has 
been added to the plot, representing the pit slope.  

Planes are added to stereonet plots with the Add Plane 
option, as described below.  

Add Plane 

Before we add the plane, let's change the Convention. In 
DIPS, orientation coordinates can be displayed in either 
Pole Vector (Trend/Plunge) format, or Plane Vector 
format. Right now we want to use the Plane Vector 
Convention, which for this file is DIP/DIPDIRECTION, 
since this is the Global Orientation Format.

GEO.DCPP.01.22 Rev. I

Look closely at the data clustering and the data TYPE.  
Note the clustering of bedding features and the two 
clusters of shear features. These may behave very 
differently from similarly oriented joints or extension 
fractures, and should be considered separately.  
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To change the Convention, click the left mouse button on 
the box at the lower right of the Status Bar, which should 
currently display Trend/Plunge. It should then display 
Dip / DipDirection. The Convention can be toggled at any 
time in this manner.  

Now let's add the plane.  

LM Select: Select -+ Add Plane 

1. On the Pole Plot, move the cursor to 
APPROXIMATELY the coordinates 45 / 135 (Dip I 
DipDirection). Remember that the cursor coordinates 
are displayed in the Status Bar.  

2. Click the LEFT mouse button, and you will see the 
Add Plane dialog.

[Add Plae -xl

pit slope 
:-.  

DIPIenePLRb&-IO P 13 

:Darn dight~eflveio~p'ev ..  

Figure 4-4: Add Plane dialog.  

3. If you did not click at exactly 45 I 135, don't worry, 
you can now enter the exact coordinates in the Add 
Plane dialog.  

4. You can also enter an optional descriptive label, for 
.example, "pit slope". If you wish, you can clear the ID 
checkbox, so that only the label "pit slope" appears.  

5. Select OK, and the plane (great circle) representing 
the overall pit slope, will be added to the plot.
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QW"? 

IL 

L

Page 141 of 168 December 14, 2001



Calculation 52.27.100.732, Rev. 0, Attachment B, Page _•of 90 

Toppling, Planar Sliding, Wedge Sliding 
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Now let's view the contoured data.  

Select: View -+ Contour Plot

Figure 4-5: Unweighted Contour Plot of EXAMPPIT.DIP data.  

A useful rule of thumb is that any cluster with a 
maximum concentration of greater than 6% is very 
significant. 4-6% represents a marginally significant 
cluster. Less than 4% should be regarded with suspicion 
unless the overall quantity of data is very high (several 
hundreds of poles). Rock mechanics texts give more 
rigorous rules for statistical analysis of data.  

Now let's apply the Terzaghi Weighting to the data, to 
account for bias correction due to data collection on the 
(planar) traverse.  

Select: View -+ Terzaghi Weighting 'S

Vol
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Observe the change in adjusted concentration for the set 
nearly parallel to the mapping face (the "bedding plane" 
joint set).  

00......... . 0. 0 .. .......... .... ______.00.m 

•uc 7o • 0• "'e .!• •::l ,i;.: -:;::-.::::::i:. :;:•:•!• ::,. • ::•,.'(•; : •.

Figure 4-6: WEIGHTED Contour Plot of EXAMPPIT.DIP data.  

See the DIPS Help system for more information about the 
Terzaghi Weighting procedure used in DIPS.  

The Terzaghi Weighting option works as a toggle, so re
select the option to restore the original unweighted 
Contour Plot.  

Select: View -+ Terzaghi Weighting 

Contours can be overlaid on a Pole Plot with the Overlay 
Contours option. Let's do that now.

GEO.DCPP.01.22 Rev. 1
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Observe the effect of bias 
correction on the bedding 
plane joint set in particular.
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Overlay of Contours and Poles

r�;i 
LM•i

To overlay contours, let's first view the Pole Plot again.  

Select: View -+ Pole Plot 

Note that the Symbolic Pole Plot is still in effect, and does 
NOT get reset when you switch to viewing other plot 
types (eg. the Contour Plot). To overlay contours: 

Select: View -+ Overlay Contours

Let's change the Contour Mode to Lines, so that the Poles 
are easier to see.  

Select: Setup -+ Contour Options 

In the Contour Options dialog, set the Mode to Lines and 
select OK.  

TIl M .. S . .. 'I... .. . IA1

Figure 4-7: Overlaid Contours on Pole Plot.
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Although the SHEARS are not 
numerous enough to be 

represented in the contours, 
they may have a dominating 
influence on stability due to 

low friction angles and 
inherent persistance.

Notice that the Shears in this example are not 
represented in the contours. This is because the number 
of mapped shears is small. However, due to the low 
friction angle and inherent persistence, the shear features 
may have a dominating influence on stability. It is always 
important to look beyond mere orientations and densities 
when analyzing structural data.

Creating Sets

Now use the Add Set Window' option to delineate the joint 
contours, and create four Sets from the four major data 
concentrations on the stereonet.  

Select: Sets --> Add Set Window 

See the Quick Tour of DIPS, the first tutorial in this 
manual, for instructions on how to create Sets. Also see the 
DIPS Help system for detailed information.

Figure 4-8: Set Windows formed around the four principal joint 
sets, using the Add Set Window option.
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Note that in Figure 4-8, the display of the planes was 
hidden using the Show Planes option. Show Planes can be 
used at any time to show or hide the planes on any given 
view.

Surface Condition

For stability analysis it will be necessary to assume a 
value for friction angle on the joint surfaces.  

For the purpose of estimating a friction angle, we will 
create a Chart of the data in the SURFACE column of the 
EXAMPPIT.DIP file.  

Select: Select -+ Chart 

In the Chart dialog, select SURFACE from the pull-down 
list of columns.

: XI 

-Dfktato PR0t 

'iISURFACE 
iz i0661iat"v (e.g. joint shear. beddingy, 

wFPlotType' SetFilter 
K~Hstogram ISe 

Zi~iZ Cancel

Figure 4-9: Chart dialog.
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Also, for the purpose of our first analysis, which will be a 
toppling analysis, we are concerned primarily with the 
joint set at the lower right of the stereonet. Use the Set 
Filter option in the Chart dialog, to select this Set (in this 
example, Set ID = 4, yours may be different, depending on 
the order in which you created the Sets).  

Select OK, and the Chart will be created.

View the SURFACE 
properties and estimate a 

frction angle.

Figure 4-10: Histogram of SURFACE properties for joint set 4.  

The joint set illustrated above is predominantly rough 
(considering both "rough" and "v.rough" features), and so 
a friction angle of 35 - 40 degrees (a conservative 
estimate) will be used.  

We are finished with the Chart, so close the Chart view 
and we will return to the stereonet.
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Statistical Info 

We will now add some statistical information to the Pole 
"Plot, by displaying Variability cones around the mean Set 
orientations. (The shears will be considered separately 
where appropriate).  

If you are still viewing the overlaid Contours on the Pole 
Plot, toggle this off by re-selecting Overlay Contours.  

Select: View -- Overlay Contours 

Variability Cones 

- Variability cones are displayed through the Edit Sets 
dialog.  

__ Select: Sets -- Edit Sets

1- 1 !Set (unweigIhted' 7 . 1181 :1M I_ 
2 1 !Set (weighted 1-9 18 1ý-____________ 

3 2'St~uweghtd)57 133 IM
4. 2 iSez Lweighted) 156 134 1=11
513 3 Set (uneighted) 75 F89 :l!

[6j:: :-3wahtd S7 Tr- I 

rJ4" iSet (uwweeii~ed) 71 132 _____1 -________ 

I7. r 7 -* 

JAJ•. : ;,. I ,. - _- ' : ' , : .• .; ' . " • - i; [ .• ;=- .' • . L i .. • . . ." ,

Figure 4-11: Edit Sets dialog.  

For the remainder of this tutorial we will be dealing with 
WEIGHTED Set information, so select Weighted planes in 
the Type of Planes pull-down in the Edit Sets dialog.
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1. Notice that only the WEIGHTED planes are now 

listed in the dialog. r .  
3. 

2. Select all four planes by selecting the row ID buttons NAP

at the left of the dialog. You can click and drag with 0 .  

the mouse, or use the Shift and / or Ctrl keys in I 
conjunction with the mouse, to make multiple 
selections.  

3. Select the Variability checkbox.  

4. Select the One Standard Deviation and Two Standard I 
Deviation checkboxes.  

5. Select OK. I .  

You now have variability cones representing one and two l 
standard deviations of orientation uncertainty centered " 
on the calculated means.  

If you previously toggled the display of planes OFF with t 

the Show Planes option, toggle the display back ON again, 
by re-selecting Show Planes, since we want to view the .  
Added Plane representing the pit slope.  

Select Select -• Show Planes 

However, we do not currently want to display the MEAN I 
planes, so let's toggle their visibility OFF for now. We'll 
revisit the Edit Sets dialog.  

Select Sets --+ Edit Sets I 
1. Select ALL planes. UI..  

2. Clear ALL Visibility checkboxes (ie. Pole, Plane, ID 
and Label). o 

3. Select OK.  

Your screen should look like Figure 4-12. C "
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A TOPPLING ANALYSIS.  
using stereonets is based on: 

1) Variability cones 
indicating the extent of 
the joint set population., 

2) A Slip Limit based on the 
joint friction angle and pit 
slope.  

3) Kinematic 
considerations.

Toppling 

(The following analysis is based on Goodman 1980. See 
the reference at the end of this tutorial).  

Using the variability cones generated above, proceed with 
a toppling analysis. Assume a friction angle of 35 degrees, 
based on the surface condition of the joints (see Figure 4
10).  

Planes cannot topple if they cannot slide with respect to 
one another. Add a second plane representing a "slip 
limit" to the stereonet with the Add Plane option.  

Select Select -+ Add Plane 

Position the cursor at APPROXIMATELY 10 / 135 (Dip / 
DipDirection) and click the left mouse button.

a

U 

U
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Figure 4-12: Variability cones displayed on Pole Plot.
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In the Add Plane dialog, if your graphically entered 
coordinates are not exactly 10 / 135, then enter these 
exact coordinates and select OK. . .  

NOTE: the DIP angle for this plane is derived from the 
PIT SLOPE ANGLE - FRICTION ANGLE = 45 - 35 = 10 
degrees. The DIP DIRECTION is equal to that of the face a...  
(135 degrees). Goodman states that for slip to occur, the 
bedding normal must be inclined less steeply than a line b 0.  
inclined at an angle equivalent to the friction angle above 
the slope.  US 
Next, use the Add Cone option to place kinematic bounds6 
on the plot. When specifying cone angles, remember that 
the angle is measured from the cone axis. C 

[4] Select: Tools - Add Cone 

Click the mouse anywhere in the stereonet, and you will 
see the Add Cone dialog. Enter the following values: 

Punge 10 c 
• A n g•:i I .. .e .1: 1•-- ' ,:; I.I ,: 

These values are derived as follows: 

"* The Trend is equal to the DIP DIRECTION of the face 
plus 90 degrees (135 + 90 = 225). 1;.  

" The 60 degree cone angle will place two limits plus I 
minus 30 degrees with respect to the face DIP 
DIRECTION as suggested by Goodman - planes must 
be within 30 degrees of parallel to a cut slope to 
topple. An earlier 15 degree limit proposed by 
Goodman was found to be too small.  

r~i
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The zone outlined in 
Figure 4-13 is the toppling 
region. Any POLES plotting 
within this region indicate a 

toppling nsk....

Figure 4-13: Toppling risk is indicated by the relative number of 
poles within joint set which fall within the outlined pole toppling 
region. Visual estimate indicates about 25 - 30% toppling risk for 
joint set 4, based on the 95% variability cone.  

The two variability cones give a statistical estimate of the 
toppling risk for the joint set in question. A visual 
estimate indicates that 25 - 30% of the theoretical 
population of joint set 4 falls within the toppling zone. It 
could be said that, ignoring variability in the friction 

angle, there is an approximate toppling risk of 30%.  
Frictional variability could be introduced by overlaying 
additional slip limits corresponding to say 30 and 40 
degrees.

GEO.DCPP.01.22 Rev. 1

Select OK on the Add Cone dialog.  

The zone bounded by these new curves (outlined in Figure 
4-13 below) is the toppling region. Any Poles plotting 
within this region indicate a toppling risk. Remember that 
a near horizontal pole represents a near vertical plane.
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Planar Sliding 

Before we proceed with the Planar Sliding analysis, let's 
A PLANAR SLIDING analysis first delete the cone added for the Toppling analysis.  

uses Variability Cones, a 
Friction cone, and a Daylight Select: Tools -- Delete -a. Delete All 

SEnvelope, to test for 
combined frictional and 

kinematic possibility of planar This will delete the cone, and also any Added Text and 
sliding. Arrows which you may have added to the view.  

Now, in the Edit Planes dialog, we will: 

0 delete the "slip limit" plane that we added for the 
Toppling analysis, and 

0 display a Daylight Envelope for the pit slope plane.  

Select: Select Edit Planes 

1 ,1 145 1135 11= l,wipil slope :..  

r e 

Figure 4-14: Edit Planes dialog.  

1. Select the second Added Plane and select Delete.  

2. Select the first Added Plane (the Pit Slope), and select 
the Daylight Envelope checkbox.

GEO.DCPP.01.22 Rev. I
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3. Select OK.  

Q •A Daylight Envelope for the Pit Slope plane should be 

visible on the stereonet.  

A Daylight Envelope allows us to test for kinematics 
Q _(ie. a rock slab must have somewhere to slide into 

"free space). Any pole falling within this envelope is 

kinematically free to slide if frictionally unstable.  

Q Finally, let's place a POLE friction cone at the center of 

the stereonet.  

Select: Tools -- Add Cone 

Click the mouse anywhere in the stereonet, and enter 

the following values in the Add Cone dialog:

6 90 

Select OK.  

Note that the friction angle is equal to our friction 

estimate of 35 degrees, determined earlier in this 

tutorial.  

Any pole falling outside of this cone represents a plane 

which could slide if kinematically possible.  

The crescent shaped zone formed by the Daylight 

Envelope and the pole friction circle therefore encloses 

the region of planar sliding. Any poles in this region 

represent planes which can and will slide. See Figure 

4-15.
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ai M W'-:'* -s-!0-0aA* 
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Note that a POLE friction 
cone angle is measured from DAYr*ArE 2EL 

the center of the stereonet. ?E 

. POLE FRICTOQN COM 

I 'V 

W03Eos35 .*.7-I 

E".I..  

Figure 4-15: Planar sliding zone is represented by crescent shaped 
region. Only a small area overlaps the bedding joint set, therefore 
the risk of planar sliding is minimal.  

Again, the variability cones give a statistical estimate of 
failure probability. Only a small percentage (< 5 %) of I 
the bedding joint set falls within this zone.  

Planar sliding is unlikely to be a problem. .i 

NOTE: We have been using EQUAL ANGLE projection C
throughout this analysis. When making visual estimates 
of clusters and variabilities, it is actually more " 
appropriate to use EQUAL AREA projection to reduce I' 
areal distortion and improve visual estimates.  

Wedge Sliding 

It has been shown that a sliding failure along any of the 
joint planes is unlikely. However, multiple joints can form 
wedges which can slide along the line of intersection 
between two planes.  

Li"
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For this analysis, let's switch to the Major Planes plot, 
which allows us to view planes only on the stereonet, 
without poles or contours.  

Select: View -> Major Planes 

Before we proceed with the Wedge Sliding analysis, let's 
first delete the cone added for the Planar Sliding analysis.  

Select: Tools -* Delete -+ Delete All 

This will delete the cone, and also any Added Text and 
Arrows which you may have added to the view.  

Next, let's hide the Daylight Envelope for the pit slope, 
since we do not need it for this analysis.  

Select: Select -+ Edit Planes 

In the Edit Planes dialog, select the pit slope plane, and 
clear the Daylight Envelope checkbox. Select OK.  

Next, in the Edit Sets dialog, we want to make the 
WEIGHTED MEAN planes visible (which we hid earlier 
in this tutorial), and also hide the Variability cones.

* 2>

Select: Sets -+ Edit Sets

In the Edit Sets dialog, select the four WEIGHTED MEAN 
planes, and select the Plane visibility checkbox ONLY 
Also, clear the Variability Cone and Standard Deviation 
checkboxes. Select OK 

Finally, let's add a PLANE friction cone to the stereonet.  

Select: Tools -* Add Cone 

Click the mouse anywhere in the stereonet, and enter the 
following values in the Add Cone dialog:

S
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-. 9 .. XI 
PI 

155d.~l O

Note that a PLANE fMction 
cone angle is measured from 
the perimeter (equator) of the 

: " stereonet. ý

WEDGE SLIDING may occur 
if the mean joint set 

orientation INTERSECTIONS 
fall w*hin the zone defined by 
...the fNction cone and the pit 

s, lope.

NOTE: this time we are not dealing with poles but an 
actual sliding surface or line, so that the friction angle (35 
degrees) is taken from the EQUATOR of the stereonet, 
and NOT FROM THE CENTER as before. Therefore the 
angle we enter in the Add Cone dialog is 90 - 35 = 55 
degrees.  

Select OK, and your plot should appear as follows:

Figure 4-16: Major Planes Plot showing WEIGHTED MEAN planes, 
pit slope and friction cone. Wedge sliding zone is represented by 
crescent shaped region. Since no plane intersections (black dots) 
fall within this region, wedge sliding failure should not be a 
concern.
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Using the procedure 
described above for a wedge 

analysis,: the stability of 
discrete combinations of 

shear planes, or of shear 
planes with the mean joint 

orientations, maybe 
analyzed.  

g!

¾

Toppling, Planar Sliding, Wedge Sliding 75

The zone OUTSIDE the pit slope but enclosed by the 
friction cone represents the zone of wedge (intersection) 
sliding. Any plane intersections (highlighted by black 
dots in Figure 4-16) which fall within this zone will be 
unstable. This is not the case in this example, therefore 
wedge sliding should not be a problem.  

Discrete Structures 

Finally, you should analyze the shear zones mentioned 
earlier. If these shears occur in proximity to one another 
they may interact to create local instability.  

Perform an analysis similar to the one above using 
discrete combinations of shear planes.  

"* Use the Add Plane option to add planes corresponding 
to the shear features.  

"* TIP - while using Add Plane, the Pole Snap option 
(available in the right-click menu) can be used to snap 
to the exact orientations of the shear poles.  

You should find that the risk of wedge failure along the 
shear planes is low, for this pit slope configuration.  

As a further exercise, determine whether the shears will 
interact with any of the mean joint set orientations to 
create an unstable wedge.  

Increased Local Pit Slope 

Repeat these analyses for steeper local slopes. If the 
overall slope is to be maintained at 45 degrees (see the 
first page of this tutorial), the local bench slope will have 
to be increased to accommodate the roadways. What is the 
critical local slope?

Wi 

.�:- .�
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Examine the stability of other 
pit slope orientations.  

Assume that the joint sets are 
consistent throughout the 

mine property, and perform 
the analyses described in this 

tutorial using 45 degree 
increments of dip direction 

around the pit wall.

Other Pit Orientations 

Assume that the joint sets are consistent throughout the 
mine property. Are there any slope orientations that are 
more unstable than others? Examine slope dip directions 
in 45 degree increments around the pit wall.  

HINT: 

" you can import DIPS plots into AutoCAD using the 
Copy to Metafile option in the Edit menu. This will 
copy a metafile of the current view to the clipboard, 
which can then be pasted into AutoCAD.  

" Pole or Contour plots showing mean planes and the 
selected pit slope orientation can be imported into a 
plan of the pit and placed in their appropriate 
orientations for quick reference.

References

Goodman, R.E. 1980. Introduction to Rock Mechanics 
(Chapter 8), Toronto: John Wiley, pp 254-287.
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Navigate to the Examples folder in your DIPS installation 
folder, and open the EXAMPBHQ.DIP file. Maximize the 
view.  

ft4 . I,• ...t I MCI UflU 1 0* 1 
I- 17 16 W 0 O ~ _ 

.. 14. a0 l 

I.~ ~ ~~ 11_39 07 .  

-- • -- +-• -- ...... ++ ~~ ~~~~~~~~~~....... .. •m .... ... • ... •. . ' . -i',.++•+:: + J : t7 IS + 21a DlII+ + .+"+: . • :• =+,+ 

.... . . . . , 

Figure 5-1: EXAMPBHQ.DIP data.
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First open the EXAMPBHQ.DIP file.  

Select: File --* Open

"I.,

Oriented Core and Rockmass 
Classification 

This advanced DIPS tutorial uses the example file 
EXAMPBHQ.DIP, which you should find in the Examples 
folder of your DIPS Installation folder.  

EXAMPBHQ.DIP File

r,7-,
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The file contains 650 measurements from 2 oriented 
borehole cores. I 

The file uses the following columns: I 
* The two mandatory Orientation Columns I 
* A Traverse Column 
* 4 Extra Columns 

Orientation Columns 

The Orientation Columns, for borehole data, record alpha __ 

and beta core joint angles: 

" The alpha angle, entered in the Orient 1 column, is 
measured with respect to the core axis.  

" The beta angle, entered in the Orient 2 column, is 
measured with respect to the core reference line.  

See the DIPS Help system for detailed information about 
recording borehole data. I 

Extra Columns 

The four Extra Columns record the following information: • I 
" core position from collar 

"* intact length (calculated in a spreadsheet from 
position or recorded directly) between adjacent joints 

"• JA 

"• JR 

The latter measurements are qualitative indices of 
roughness and alteration taken from the Q Classification • - .  
.by Barton and can be quickly recorded during core 
logging. Consult any modern rock engineering text for a 
definition of these terms.  

Let's examine the Job Control information for this file.
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Job Control 

Select: Setup -+ Job Control

Jo Conro

C CAVERN: STRUCTURAL SURVEY & 
KMASS CLASSIFICATION 

S, P 

l Onenr faion Foirmat. DIP/DIPDIRECTION ,1 

ineihon6 (degrees, West ýv'e) 1 

* ~ * *, ~ T r verses 

...............
Figure 5-2: Job Control information for EXAMPBHQ.DIP file.  

Note the following: 

* The Global Orientation Format is DIP I 
DIPDIRECTION. For borehole data, the Global 
Orientation Format does NOT apply to the data in the 
Orientation Columns, but it does determine the Plane 
Vector Convention for coordinate listings in DIPS).  

* The Declination is zero in this file. Declination would, 
if present, be applied to the borehole trends 
(azimuths).  

The Quantity Column is NOT used in this file, so each 
row of the file represents an individual measurement.
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Traverses -• 

Let's inspect the Traverse Information. You can select the Fpw: 
Traverses button in the Job Control dialog (the Traverses 
dialog is also available directly in the Setup menu). k 

As you can see in the Traverse Information dialog, this 
file uses 2 borehole traverses: 

Both traverses have an Orient 1 value of 180. This " denotes a reference line that is 180 degrees from the " _.  
top of the core (ie. at the bottom of the core as it would 
be in situ). a 

The Orient 2 value indicates the drilling angle from 6 
the vertical. Traverse 1 has an Orient 2 value of 135, " 

indicating that the borehole was drilled at 135 degrees 
from the vertical, or with a plunge of 45 degrees.  Traverse 2 was drilled at 160 degrees from the a .:.  

vertical, or a plunge of 70 degrees. [ 
See the DIPS Help system for The Orient 3 value indicates the azimuth (ie. CW 
Sdetailed illustration of the agefo ot)o eonoe e~o borehole orientation o angle from compass north) of the downhole direction requirements for DIPS input. of the borehole. Orient 3 is 40 degrees for Traverse 1 and 135 degrees for Traverse 2. : 

See the DIPS Help system for detailed illustration of the a - i borehole orientation requirements for DIPS input.  

Select Cancel in the Traverse Information dialog.  

Select Cancel in the Job Control dialog.  

INA 
41 

aw
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"* tUse a spreadsheet and the 
INTACT LENGTH 

extra data' column to 
determine a value for RQD.

4

ni

Using the intact lengths, RQD (Rock Quality Designation) 
can be calculated using a spreadsheet. RQD is taken as 
the: 

Cumulative length of core pieces greater than 10 cm 
x 100 

Total length of core 

Determination of JN 

JN is the joint number. To obtain a value for this 
parameter, let's view a Contour Plot, to determine the 
number of (well) defined joint sets.  

Select View --+ Contour Plot 

Apply the Terzaghi Weighting, so that we can view the 
weighted contours.

Select View -+ Terzaghi Weighting

GEO.DCPP.01.22 Rev. 1
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Rock Tunneling Quality Index - Q 

The rock tunneling quality index Q is defined as: 

Q =(RQDIJN ) * (JR IJA) (JWlSRF) 

Consult any modern rock engineering text (see the 
references at the end of this tutorial) for more information 
if required.  

Set the water parameter JW = 1 (dry) and stress 
reduction factor SRF = 1 (moderate confinement, no stress 
problems) for this example.  

Determination of RQD

-4 
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(Note that DIPS has automatically converted the borehole 
alpha and beta angles to dip and dip direction, using the 
borehole traverse orientations.)

Of'K 3-.. ~ S.. SM t 1

View a WEIGHTED Contour 
Plot of the data.  

The three well defined joint 
sets result in a Barton JN 

value = 9.

r�i 
L�2i

Figure 5-3: Weighted Contour Plot of combined borehole data, 
converted to global orientations. The 3 well defined joint sets result 
in Barton's JN = 9.  

The three well defined joints sets result in Barton's JN = 
9.  

Now use Add Set Window to determine the mean 
orientations of the three joint sets. (See the Quick Tour of 
DIPS for details about creating Sets with the Add Set 
Window option.) NOTE: when you create the Sets, display 
the WEIGHTED mean planes, using the checkbox in the 
Add Set Window dialog.  

Finally, let's add a LINE through the center of the 
stereonet, to represent a proposed tunnel axis. Assume a 
tunnel trend of 20 degrees.  

Select: Tools -> Add Line

GEO.DCPP.01.22 Rev. 1
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1. Place the cursor at APPROXIMATELY Trend = 20 

-__-__________________ _ , degrees, and click the left mouse button (remember 
'that the cursor coordinates are visible in the Status 

•0 Bar).  

'% l; &ceal -- 2. In the Add Line dialog, if your graphically entered 

... ' orientation is not exactly 20 degrees, then enter 20 

and select OK.  

Let's view a Pole Plot.  

Select: View -- Pole Plot 

":i'• .,•N "TJt*EL 

Superimpose the tunnel axis ] W1 
on the mean joint planes to 
judge the critical joint set for | ..  

Q classification. : ] 

EqA.0 A.  

I...Figure 5-4: Mean planes with superimposed tunnel axis.  

It is not immediately obvious which is the critical joint in 
this case. However, it can be shown that joint set 1 is most 

likely to prevent any development of tension in the roof 
and therefore will reduce the self-supporting nature of the i;: 
tunnel roof. Let us then use this as the critical joint set for 
Q classification. Note the sliding wedge (closed triangle in 

the above plot formed by the three joint sets) which 
"appears in the roof of the tunnel.
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Estimation of JR and JA 6 

The next step is to use the Chart option to look at JR and 
JA. These indices can be viewed as either QUALITATIVE 
or QUANTITATIVE. Quantitative analysis allows a mean a..  
calculation and so is preferred.  

Select: Select -> Chart 

In the Chart dialog, select Data to Plot as NGI-JR, select I 
the Quantitative button, and select Set 1 in the Set Filter.  
(NOTE that Set 1 in this example is the joint set at the 
upper left of the stereonet. If you used different Set IDs, 
then enter your Set ID for this Set). Select OK. I 

S. ..... - I ,,.. --- .~ ... y * .• 

Create Quantitative Charts of I 
the JR and JA Extra Columns, __ _ _ __ _ _ __"" 

to estimate mean values of 
JR and JA forthe critical 

joint seL .  

11, 

t 

Figure 5-5: Joint Roughness, JR, for joint set 1. Mean =1.28.[.'' 

Notice the mean and standard deviation at the bottom of 

the Chart. The mean value of JR is approximately 1.28.  

Now right-click on this chart, and select Chart Properties.  
Change the Data to Plot to NGI-JA, and select OK. The mean value of JA is approximately 3.2.

GEO.DCPP.01.22 Rev. 1 December 14, 2001Page 167 of 168



* CaIcuIation.S24�4b0,732vRev. 0, Attachment B, Page'�.,9of 90

Caiculation:5,1 j-0(0;7intieCr, Attachment B, PageCsiof 90 

Oriented Core and Rockmass Classification 85

I 

j

Rock Tunnelling Ouality Index. Q 
Note; *Bolts "refers to pattern bolting unless specified

I,.

Figure 5-6: Tunneling support guidelines, based on the tunneling 
quality index Q (bolt lengths modified for cablebolting). Ref. 1, after 
original Ref. 3.
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For the purposes of classification, a JR of I to 1.5 and a JA 
of 3 to 4 would be adequate in this example.  

Calculation of Q Values 

RQD, as calculated in the spreadsheet was 60%. Using the 
JN value of 9, and the upper and lower limits for JR and 
JA (see above), gives: 

"* AlowerQof(60/9)*(1/4)*(1/1) =1.7 

"• AnupperQof(60/9)*(1.5/3)*(1/1)=3.3 

This range of values can now be used for further empirical 
support design according to Barton's design charts - see 
Figure 5-6. Real values for JW may be evaluated 
qualitatively from borehole inflow notes. SRF can be 
determined from the depth of the proposed excavation 
according to Barton.
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